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1   Rozpoczęcie pracy

Oprogramowanie Kodak Capture Pro to idealne rozwiązanie do zastosowań 
wymagających obrazowania, przetwarzania formularzy i przepływu pracy oraz 
jako aplikacja niezależna. Zarządza skanowaniem jedno- i dwustronnym, 
indeksowaniem i pracą wsadową w trybie kolorowym, czarno-białym oraz 
w skali szarości. Wsady można łatwo eksportować do wielu popularnych 
aplikacji. Oprogramowanie Capture Pro umożliwia pełne wykorzystanie 
możliwości skanera i uzyskanie maksymalnej wydajności. Wszystkie funkcje 
realizowane są programowo, nie jest wymagana specjalna akceleracja 
sprzętowa.

Oprogramowanie Capture Pro zaprojektowano pod kątem dużej szybkości, 
dokładności i łatwości obsługi. Umożliwia uzyskanie przez skaner 
optymalnych efektów i maksymalnej wydajności. Szybki wyświetlacz 
wielostronicowy prezentuje obrazy i opcjonalne dane indeksu podczas 
skanowania dokumentów. Zarządzanie skanowaniem upraszcza kompletny 
zestaw narzędzi z ikonami. 

Niniejszy przewodnik zawiera opis podstawowych czynności związanych 
z utworzeniem nowego wsadu, skanowaniem dokumentów, edytowaniem 
zeskanowanych obrazów i przetwarzaniem wyjściowym wsadu. Dodatkowo 
opisano okna, menu i narzędzia.

Dodatkowa 
dokumentacja

Oprócz tego Podręcznika użytkownika dostępna jest również następująca 
dokumentacja:

• Pomoc online — zawiera informacje dotyczące produktu, w tym 
szczegółowy opis jego konfiguracji i interfejsu użytkownika oraz wielu 
funkcji zaawansowanych. Do wyszukiwania informacji w pliku pomocy służą 
spis treści, indeks lub funkcja wyszukiwania. 

Aby uzyskać dostęp do Pomocy, naciśnij klawisz F1, wybierz przycisk 
Pomoc w oknie dialogowym lub kliknij ikonę „?”. w górnym prawnym rogu 
dowolnego okna.

• Podręcznik referencyjny — zawiera opis prostych procedur 
umożliwiających szybkie rozpoczęcie pracy z oprogramowaniem Capture 
Pro, w tym dotyczących jego instalowania i uruchamiania. Zawiera też 
procedury skanowania przy użyciu domyślnych wstępnie zdefiniowanych 
konfiguracji zadań. Wersja PDF tego podręcznika znajduje się w sekcji 
Manuals & Guides (Podręczniki i przewodniki) na stronie internetowej 
pomocy technicznej do oprogramowania Capture Pro: 
https://support.alarisworld.com/capture-pro-software#Manuals

• Podręcznik administratora — zawiera szczegółowe informacje dotyczące 
tworzenia konfiguracji zadań skanowania, które są najbardziej efektywnym 
sposobem korzystania z oprogramowania Capture Pro. Zawiera również 
informacje dotyczące konfiguracji stron, kodów kreskowych i kodów 
separujących, automatycznego importowania i wiele innych. Wersja PDF 
tego podręcznika znajduje się w sekcji Manuals & Guides (Podręczniki 
i przewodniki) na stronie internetowej pomocy technicznej do 
oprogramowania Capture Pro: 
https://support.alarisworld.com/capture-pro-software#Manuals

https://support.alarisworld.com/capture-pro-software#Manuals
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• Network Edition: System Guide (Podręcznik do systemu w wersji 
sieciowej) — zawiera procedury instalacji oprogramowania w wersji 
sieciowej, czyli Capture Pro Network Edition. Wersja PDF tego podręcznika 
znajduje się w sekcji Manuals & Guides (Podręczniki i przewodniki) 
na stronie internetowej pomocy technicznej do oprogramowania Capture 
Pro: https://support.alarisworld.com/capture-pro-software#Manuals

• Uwagi dotyczące wydania — zawierają informacje niedostępne 
w pozostałej dokumentacji. Uwagi dotyczące wydania dostępne są pod 
adresem www.kodakalaris.com/go/kcsdownloads, po przejściu do sekcji 
Workstation/Client Software (Oprogramowanie dla stacji roboczej/klienta).

Terminologia Przed rozpoczęciem należy zapoznać się z podstawową terminologią 
używaną w oprogramowaniu Capture Pro. 

Oprogramowanie Capture Pro ma charakter „zadaniowy”. Zadanie to 
konfiguracja metody przechwytywania i przetwarzania zestawu dokumentów, 
które mają być skanowane. 

Aby zeskanować dokumenty w ramach zadania, należy utworzyć wsad, 
w którym będą przechowywane zeskanowane dokumenty, obrazy i dane 
przed ich przetworzeniem wyjściowym.

Oprogramowanie Capture Pro organizuje zeskanowane dokumenty 
w następującą hierarchię:

• Wsad: zawiera co najmniej jeden zeskanowany dokument (odpowiednik 
folderu lub teczki do przechowywania kilku osobnych dokumentów).

• Dokument: zawiera przynajmniej jedną stronę powiązaną z jednym 
obiektem (np. zawartość koperty).

• Strona: to fizyczny arkusz papieru umieszczony w skanerze w celu 
utworzenia obrazów.

• Obraz: elektroniczna reprezentacja zeskanowanych stron.

Przetwarzanie wyjściowe to proces przesyłania wsadu w wybranym formacie 
do żądanego systemu wyjściowego lub lokalizacji.

Uruchamianie 
oprogramowania 
Capture Pro

Jeśli nie jest używana edycja Index Only ani Auto Import, należy sprawdzić, 
czy skaner jest włączony i prawidłowo podłączony do komputera. 
W przypadku kupienia opcjonalnego klucza sprzętowego należy sprawdzić, 
czy jest on podłączony do portu USB komputera. 

UWAGI:

• W klientach edycji Network Edition zostanie wyświetlony alert informujący 
o uzyskiwaniu licencji.

• Klienty oprogramowania Capture Pro Software Network Edition uruchomią 
procedurę początkowej synchronizacji z oprogramowaniem Capture Pro 
Server.

• Kliknij dwukrotnie ikonę oprogramowania Capture Pro 
na pulpicie lub

• wybierz kolejno opcje: Start > Programy > Kodak > Kodak 
Capture Pro Software.

https://support.alarisworld.com/capture-pro-software#Manuals
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Wybór skanera Przy pierwszym uruchomieniu oprogramowania Capture Pro zostanie 
wyświetlony następujący komunikat: Your scanner has not been selected. 
Do you want to set it up now? (Nie wybrano skanera. Skonfigurować go 
teraz?). Kliknij przycisk Yes (Tak), aby wyświetlić ekran Workstation Setup 
(Konfiguracja stacji roboczej). Na tym ekranie możesz wybrać z listy 
dostępnych skanerów ten, który będzie używany wraz z oprogramowaniem. 
Podczas kolejnych uruchomień oprogramowania ten etap zostanie pominięty.

1. Kliknij przycisk Select (Wybierz). Zostanie wyświetlony ekran Select 
scanner (Wybór skanera).

2. Wybierz skaner zainstalowany na komputerze i kliknij przycisk OK. 
Zostanie wyświetlony ekran Szybki start (Quick start).

3. Kliknij przycisk OK na ekranie Workstation Setup (Konfiguracja stacji 
roboczej).

4. Jeśli chcesz importować obrazy do oprogramowania Capture Pro bez 
używania lokalnego skanera lub obsługi ręcznej, wybierz opcję Auto 
Import (Importowanie automatyczne).
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Quick Start (Szybki 
start)

Ekran Quick start (Szybki start) zawiera menu najczęściej używanych funkcji 
i kafelków zadań.

Na stronie Kafelki zadań (Job tiles) są wyświetlane zadania, które zostały 
skonfigurowane. Kafelki są wyświetlane w porządku alfabetycznym i mogą 
zmieniać kolor w przypadku dodania lub usunięcia innych zadań.

UWAGA: Dłuższe nazwy zadań, które nie mieszczą się na przycisku, zostaną 
obcięte. Pełna nazwa zadania zostanie wyświetlona 
po umieszczeniu wskaźnika myszy na przycisku. Producent zaleca 
stosowanie takich nazw zadań, których pierwsze wyrazy są 
unikatowe i pozwalają zidentyfikować zadanie.

Batch Manager (Menedżer wsadów) — umożliwia otwieranie istniejących 
wsadów dokumentów, tworzenie nowych wsadów oraz wyświetlanie stanu 
istniejących wsadów.

Main Menu (Menu główne) — wyświetla główny ekran oprogramowania 
Capture Pro. Na tym ekranie można ręcznie otwierać wsady lub tworzyć nowe, 
rozpoczynać skanowanie dokumentów, modyfikować konfigurację zadań, 
zmieniać ustawienia użytkowników i grup oraz wykonywać zadania związane 
z konfigurowaniem systemu.

Logout (Wyloguj) — umożliwia wylogowanie bieżącego użytkownika.

Exit (Zakończ) — kończy pracę oprogramowania Capture Pro.

Kliknięcie kafelka zadania powoduje utworzenie nowego wsadu i rozpoczęcie 
skanowania zgodnie z konfiguracją zadania. Po przetworzeniu wyjściowym 
zadania ponownie zostanie wyświetlony ekran Quick start (Szybki start).

UWAGI: 

• Doświadczeni użytkownicy, którzy nie chcą korzystać ze strony Job tiles 
(Kafelki zadań) ekranu Quick start (Szybki start), mogą wyłączyć ten ekran. 
W tym celu należy wyczyścić pole wyboru Quick Start View (Widok Szybki 
start) w oknie dialogowym Workstation Setup (Konfiguracja stacji roboczej). 
Aby otworzyć okno dialogowe Workstation Setup (Konfiguracja stacji 
roboczej), należy wybrać kolejno polecenia File > Workstation Setup 
(Plik > Konfiguracja stacji roboczej) na ekranie głównym. 

• Aby przejść z ekranu „Main Menu” (Menu główne) do ekranu „Quick start” 
(Szybki start), można kliknąć ikonę „Quick start” (Szybki start) na pasku 
narzędzi „View” (Widok).

• Polecenie „Szybki start” (Quick Start) jest niedostępne w edycjach Index 
Only i Auto Import.
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Okno dialogowe 
Batch Manager 
(Menadżer wsadów)

Jeśli nie włączono wyświetlania ekranu Quick Start View (Widok Szybki start), 
po zalogowaniu do oprogramowania Capture Pro zostanie wyświetlone okno 
dialogowe Batch Manager (Menedżer wsadów). Okno dialogowe menedżera 
wsadu można również wyświetlić, wybierając kolejno Batch > Open (Wsad > 
Otwórz). Za pomocą tego okna można zarządzać wszystkimi wsadami 
powiązanymi z konfiguracjami zadań.

Available jobs (Dostępne zadania) — wyświetla listę wszystkich dostępnych 
konfiguracji zadań. Wybierz opcję batch (wsad) z dowolnej z wyświetlonych 
konfiguracji zadań.

Batches of the selected job (Wsady wybranego zadania) — wyświetla pola 
Job Name (Nazwa zadania), Batch Name (Nazwa wsadu), Time Created 
(Czas utworzenia), Batch Status (Stan wsadu) i Locked By (Zablokowane 
przez) dla wybranych zadań.

Show Options (Wyświetl opcje) — wyświetla okno dialogowe Show Options 
(Wyświetl opcje) umożliwiające wybranie stanów (np. Available [Dostępność], 
Processing [Przetwarzanie] itp.) do wyświetlenia w polu Batch Status 
(Stan wsadu) w oknie dialogowym menedżera wsadów.

Open (Otwórz) — wyświetla wsad wybrany z listy. Polecenie Open (Otwórz) 
nie powoduje otwarcia wsadu oznaczonego jako In Use (W użyciu). Do 
otwarcia istniejącego wsadu niezbędne są uprawnienia do odczytu/zapisu 
w lokalizacji zeskanowanego obrazu.
New (Nowy) — wyświetla okno dialogowe New Batch (Nowy wsad), które 
umożliwia utworzenie nowego wsadu.

Kliknij, aby wyświetlić wszystkie wsady dostępne we wszystkich 
konfiguracjach zadań.

Kliknij, aby ukryć wszystkie wsady dostępne we wszystkich 
konfiguracjach zadań.
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Rename (Zmień nazwę) — wyświetla okno dialogowe Rename Batch 
(Zmień nazwę wsadu) umożliwiające zmianę nazwy wybranego wsadu.
Delete (Usuń) — umożliwia usunięcie wybranego wsadu. Zostanie 
wyświetlone okno dialogowe potwierdzenia zamiaru usunięcia.
Output (Przetwarzanie wyjściowe) — przesyła wsad do przetworzenia. 
UWAGA: W przypadku licencji z grupy A i B na potrzeby przetwarzania 

wyjściowego wsadów należy podłączyć skaner fizyczny. W przypadku 
potrzeby przetworzenia wyjściowego wsadu bez podłączania skanera 
jest dostępna dodatkowo płatna licencja na indeksowanie.

Close (Zamknij) — zamyka okno dialogowe.

Tworzenie nowego 
wsadu

W celu zeskanowania dokumentów należy utworzyć nowy wsad lub otworzyć 
istniejący wsad, w którym zostaną umieszczone zeskanowane dokumenty. 
W większości przypadków administrator systemu skonfiguruje wcześniej 
zadania, z których można skorzystać. Zadania te zostaną wyświetlone w oknie 
dialogowym menedżera wsadu.

Aby utworzyć nowy wsad:

1. Uruchom oprogramowanie Capture Pro. Zostanie wyświetlone okno 
dialogowe Batch Manager (Menedżer wsadów).

2. Wybierz pozycję New (Nowy). Zostanie wyświetlone okno dialogowe New 
Batch (Nowy wsad).

3. Wybierz konfigurację zadania z listy rozwijanej Job Name (Nazwa 
zadania). Nowy wsad zostanie zeskanowany i poddany przetwarzaniu 
wyjściowemu zgodnie z konfiguracją zadania.

4. W razie potrzeby wprowadź nazwę nowego wsadu w polu Batch name 
(Nazwa wsadu). Domyślnie oprogramowanie Capture Pro sugeruje nazwę 
nowego wsadu na podstawie nazwy ostatniego wsadu utworzonego dla 
danej konfiguracji zadania. Jeśli na przykład nazwa ostatniego wsadu to 
Formularz030, domyślną nazwą nowego wsadu będzie Formularz031.
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UWAGA: W przypadku klientów edycji sieciowej. Jeśli w konfiguracji 
stacji roboczej zostanie wyłączona opcja Enable Job Level 
Batch Numbering (Włącz numerowanie wsadów na poziomie 
zadania) i nazwa zadania wsadowego będzie zawierać ciąg 
<BATCH_COUNTER>, w oknie nazwy zadania wsadowego 
zostanie wyświetlony komunikat „Set by System” (Ustawione 
przez system) i nie będzie możliwa zmiana nazwy.

5. W razie potrzeby w polu Starting document ID wpisz identyfikator 
dokumentu rozpoczynającego. Identyfikator dokumentu rozpoczynającego 
to identyfikator przypisywany pierwszemu dokumentowi we wsadzie. 
W większości przypadków identyfikator ten ma wartość 1. Domyślnie 
oprogramowanie sugeruje numer dokumentu rozpoczynającego zgodnie 
z konfiguracją zadania.

6. Kliknij przycisk OK. W oknie głównym zostanie wyświetlony panel Image 
Viewer (Przeglądarka obrazów) z przypisaną nazwą wsadu. Panele Image 
Viewer (Przeglądarka obrazów), Batch Explorer (Eksplorator wsadów) 
oraz Thumbnail Viewer (Przeglądarka miniatur) pozostaną puste aż 
do uruchomienia skanowania.

7. Nowy wsad można też utworzyć, klikając ikonę New Batch (Nowy wsad) 
na pasku narzędzi.

Otwieranie 
istniejącego wsadu

Procedura otwierania istniejącego wsadu:

1. Wybierz kolejno Batch > Open (Wsad > Otwórz). Zostanie wyświetlone 
okno dialogowe Batch Manager (Menedżer wsadów). W zależności od 
ustawień zostaną wyświetlone wsady ze wszystkich konfiguracji zadań.

2. Zaznacz żądany wsad i kliknij polecenie Open (Otwórz). Wybrany wsad 
zostanie wyświetlony w oknie Image Viewer (Przeglądarka obrazów) oraz 
Batch Explorer (Eksplorator wsadów). Teraz możesz pracować 
z wybranym wsadem.

3. Kliknięcie ikony Open Batch (Otwórz wsad) powoduje otwarcie okna 
dialogowego Batch Manager (Menedżer wsadów).

UWAGA: W przypadku skanowania w środowisku wieloskanerowym, 
gdy wybrany wsad już jest otwarty na innej stacji roboczej, 
oprogramowanie Capture Pro nie zezwoli na otwarcie tego 
wsadu. Zostanie wyświetlony następujący komunikat: The 
batch cannot be opened because it is currently in use by 
another user (Nie można otworzyć wsadu, ponieważ jest on 
używany przez innego użytkownika). 
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Usuwanie wsadu Usunięcie wsadu powoduje skasowanie zarówno obrazów, jak i całej struktury 
podkatalogów wybranego wsadu.

1. Wybierz kolejno Batch > Open (Wsad > Otwórz). Zostanie wyświetlone 
okno dialogowe Batch Manager (Menedżer wsadów). W zależności od 
ustawień zostaną wyświetlone wsady ze wszystkich konfiguracji zadań.

2. Zaznacz wsad do usunięcia i kliknij polecenie Delete (Usuń). Zostanie 
wyświetlony komunikat Are you sure you want to delete the selected 
batch „XXXXX”? (Czy na pewno usunąć wybrany wsad „XXXXX”?).

3. Kliknij przycisk OK.
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Korzystanie z zadań W niniejszej części omówione zostały podstawowe czynności związane 
z utworzeniem nowego wsadu, skanowaniem dokumentów i generowaniem 
plików wyjściowych. Szczegółowe informacje dotyczące indeksowania, 
konfiguracji stref OCR, odczytywania separatorów, wybierania różnych źródeł 
wyjściowych itp. można znaleźć w Podręczniku administratora 
oprogramowania Kodak Capture Pro.

UWAGA: Poszczególne działania dostępne w oprogramowaniu Capture Pro 
można wykonać na kilka sposobów. Aby na przykład otworzyć wsad, 
można wybrać kolejno pozycje Batch > Open (Wsad > Otwórz) 
z paska menu, można kliknąć przycisk Open Batch (Otwórz wsad) 
na pasku narzędzi lub nacisnąć klawisz skrótu F3. W tym 
podręczniku przedstawiono wykonywanie działań przy użyciu paska 
menu. Pełną listę menu, przycisków na paskach narzędzi i klawiszy 
funkcyjnych zawiera: „Interfejs użytkownika” na stronie 17.

1. Uruchom oprogramowanie Capture Pro, jeśli nie zostało uruchomione 
wcześniej. Zostanie wyświetlone okno dialogowe Batch Manager 
(Menedżer wsadów).

2. Kliknij pozycję New (Nowy). Zostanie wyświetlony ekran New Batch 
(Nowy wsad).

3. Wybierz żądaną konfigurację zadania z listy rozwijanej Job name 
(Nazwa zadania). Pole Batch name (Nazwa wsadu) i Starting document ID 
(Identyfikator dokumentu rozpoczynającego) zostaną uzupełnione 
automatycznie. Zawartość tych pól można w razie potrzeby zmodyfikować. 
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4. Kliknij przycisk OK. Zostanie wyświetlony ekran główny i można rozpocząć 
skanowanie. 

5. Umieść stos dokumentów przeznaczonych do skanowania na tacy 
wejściowej skanera.

6. Kliknij przycisk Start. Skaner będzie pobierał kolejne strony.

7. Po zeskanowaniu dokumentów można wykonać niezbędne czynności 
edycyjne (usunąć puste strony, obrócić obrazy, przyciąć je itp.). Krótki opis 
niektórych z dostępnych opcji zawiera: „Opcje edytowania” na stronie 11.

8. Gdy wsad jest gotowy, wybierz polecenie Batch > Output (Wsad > 
Przetwarzanie wyjściowe). Rozpocznie się przetwarzanie wyjściowe 
wsadu i zostanie wyświetlony ekran New Batch (Nowy wsad) 
umożliwiający rozpoczęcie nowej sesji skanowania, a przetwarzanie 
będzie wykonywane w tle. 

UWAGA: W przypadku licencji z grupy A i B na potrzeby przetwarzania 
wyjściowego wsadów należy podłączyć skaner fizyczny. 
W przypadku potrzeby przetworzenia wyjściowego wsadu bez 
podłączania skanera jest dostępna dodatkowo płatna licencja 
na indeksowanie.

Zeskanowane obrazy zostaną zapisane w żądanej lokalizacji. 
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Opcje edytowania Przed rozpoczęciem przetwarzania wyjściowego wsadu przejrzyj obrazy, 
aby upewnić się, że wyglądają tak, jak powinny. Jeśli zachodzi potrzeba ich 
skorygowania, dostępne są odpowiednie narzędzia. W tej części podręcznika 
zostaną przedstawione procedury związane z najczęściej używanymi 
funkcjami edycji obrazów (ich obracanie, usuwanie, przycinanie itp.). 
Procedury dzielenia i łączenia obrazów opisano w podręczniku administratora 
oprogramowania Kodak Capture Pro. 

Wszystkie opcje menu i paska narzędzi opisano w rozdziale 2: Interfejs 
użytkownika.

Obracanie obrazu Oprogramowanie Capture Pro umożliwia automatyczne obracanie obrazów 
w trakcie procesu skanowania lub obracanie ręczne po zakończeniu 
skanowania. Obrazy można obracać o 90, 180 lub 270 stopni w prawo.

Aby ręcznie obrócić obrazy w istniejącym wsadzie:

1. Kliknij pojedyncze (lub zgrupowane) obrazy, strony lub dokumenty na liście 
wyświetlanej w oknie Batch Explorer (Eksplorator wsadów) lub Image 
Viewer (Przeglądarka obrazów).

2. Wybierz kolejno pozycje Tools > Rotate (Narzędzia > Obróć) > 90, 180 lub 
270. Obrócone obrazy zostaną wyświetlone w oknie Image Viewer 
(Przeglądarka obrazów).
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Rysowanie obszaru Narzędzie rysowania obszaru umożliwia zaznaczenie prostokątnego 
fragmentu obrazu i usunięcie jego zawartości za pomocą polecenia Blank 
(Wyczyść) lub przycięcie obrazu do wielkości prostokąta za pomocą polecenia 
Crop (Przytnij).
1. Kliknij obraz do przycięcia lub wyczyszczenia w oknie Image Viewer 

(Przeglądarka obrazów).
2. Wybierz kolejno pozycje Tools > Draw Region (Narzędzia > Rysuj obszar). 
3. Kliknij i przeciągnij kursor rysowania obszaru, aby utworzyć prostokątny 

obszar zaznaczenia obrazu. Zwolnij kursor. Prostokąt zmieni kolor 
na zielony.

4. Przytnij obraz do zaznaczonego fragmentu lub wyczyść zaznaczony 
fragment.

Aby anulować zaznaczenie regionu:
• Kliknij prawym przyciskiem myszy obraz zawierający zielony prostokąt 

i wybierz polecenie Deselect Region (Anuluj zaznaczenie obszaru).

Przycinanie obrazów Za pomocą polecenia Crop (Przytnij) można odciąć obszar obrazu znajdujący 
się poza prostokątnym obszarem zaznaczonym narzędziem Draw Region 
(Rysuj obszar).

1. Kliknij obraz do przycięcia w oknie Batch Explorer (Eksplorator wsadów). 
Wybrany obraz w oknie Image Viewer (Przeglądarka obrazów) będzie miał 
czerwoną ramkę.

2. Wybierz kolejno pozycje Tools > Draw Region (Narzędzia > Rysuj obszar).
3. Kliknij i przeciągnij kursor rysowania obszaru, aby utworzyć prostokątny 

obszar zaznaczenia obrazu do zapisania. Zwolnij kursor. Prostokąt zmieni 
kolor na zielony.

4. Wybierz kolejno pozycje Tools > Crop (Narzędzia > Przytnij). Obszar 
obrazu znajdujący się na zewnątrz zielonego prostokąta zostanie usunięty, 
w oknie Image Viewer (Przeglądarka obrazów) pozostanie jedynie 
zaznaczony obszar.

5. Kliknij przycisk Yes (Tak), aby zapisać ustawienia.
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Czyszczenie fragmentu 
obrazu

Za pomocą narzędzia Blank (Wyczyść) można usunąć zawartość fragmentu 
obrazu zaznaczonego narzędziem rysowania obszaru. Obszar znajdujący się 
wewnątrz prostokąta zostanie wyczyszczony. 

1. Kliknij obraz do wyczyszczenia w oknie Batch Explorer (Eksplorator wsadów).
2. Wybierz kolejno pozycje Tools > Draw Region (Narzędzia > Rysuj obszar).
3. Kliknij i przeciągnij kursor rysowania obszaru, aby utworzyć prostokątny 

obszar zaznaczenia obrazu do wyczyszczenia. Zwolnij kursor. Prostokąt 
zmieni kolor na zielony.

4. Wybierz kolejno pozycje Tools > Blank (Narzędzia > Wyczyść). Obszar 
obrazu oznaczony zielonym prostokątem będzie teraz pusty.

5. Kliknij przycisk Yes (Tak), aby zapisać ustawienia. 

Dołączanie stron Opcja ta umożliwia zeskanowanie dodatkowych stron i dołączenie ich 
do istniejącego dokumentu. 

1. W oknie Batch Explorer (Eksplorator wsadów) wybierz dokument, 
do którego ma zostać dołączony załącznik.

2. Kliknij kolejno opcje Document > Attach Page (Dokument > Dołącz stronę).
3. Zeskanuj obrazy. Nowe strony zostaną wyświetlone na końcu wybranego 

dokumentu. 

Ponowne skanowanie 
obrazów

Podczas przeglądania wsadu zeskanowanych obrazów może się okazać, 
że niektóre dokumenty wymagają ponownego skanowania.

1. Zaznacz jedną lub więcej stron do ponownego zeskanowania.

2. Umieść w skanerze oryginały w odpowiedniej kolejności.

3. Kliknij ikonę Rescan (Zeskanuj ponownie). Obrazy zostaną zeskanowane 
ponownie i umieszczone w ich pierwotnym położeniu.

Usuwanie obrazów Aby usunąć zaznaczone obrazy z wsadu:

1. Wybierz obraz do usunięcia.

2. Wybierz kolejno opcje Edit > Delete (Edycja > Usuń). Zostanie 
wyświetlony komunikat Are you sure you want to delete the selected 
item(s)? (Czy na pewno usunąć wybrane elementy?).

3. Kliknij przycisk Yes (Tak), aby potwierdzić usunięcie.
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Usuwanie zakresu 
dokumentów

Z wsadu można też usunąć zakres dokumentów.

1. Wybierz kolejno opcje Document > Delete Range (Dokument > Usuń 
zakres). Zostanie wyświetlone okno dialogowe Delete Documents in 
Range (Usuń dokumenty z zakresu).

2. Wpisz początkowy numer grupy dokumentów do usunięcia w polu From 
Document Number (Numer dokumentu „Od”).

3. Wpisz końcowy numer grupy dokumentów w polu To Document Number 
(Numer dokumentu „Do”).

4. Kliknij przycisk OK.

Usuwanie pustych obrazów 
z wsadu

Opcja ta umożliwia usunięcie utworzonych przez skaner pustych obrazów 
z przodu lub z tyłu.

1. Wybierz kolejno Batch > Remove Blank Images (Wsad > Usuń puste 
obrazy). Zostanie wyświetlone okno dialogowe Remove Blank Images 
Setup (Konfiguracja usuwania pustych obrazów).

2. Wpisz początkowy numer dokumentu z wsadu do wyszukania pustych 
obrazów w polu Start at document (Rozpocznij od dokumentu). Domyślnie 
jest to aktywny dokument.

3. Określ próg rozmiaru (w bajtach) obrazów do sprawdzenia w polach Show 
Grayscale images below (Wyświetlaj obrazy w skali szarości poniżej) 
i Show Color images below (Wyświetlaj obrazy kolorowe poniżej). Dobre 
ustawienie dla typowych dokumentów biznesowych to 3000 bajtów 
w przypadku obrazów czarno-białych w rozdzielczości 200 dpi.

4. Zaznacz opcję Check only back sides (Sprawdź wyłącznie strony tylne), 
aby usuwać wyłącznie puste strony tylne obrazów z wsadu.

5. Zaznacz opcję Pre-select all (Wybierz wstępnie wszystkie), jeśli wszystkie 
obrazy nadają się do usunięcia.

6. Określ liczbę kolumn i wierszy do wyświetlenia w polu Display layout 
(Układ wyświetlania). Na ekranie SVGA 1024 x 768 macierz 14 x 7 
umożliwia wyświetlenie 98 obrazów.
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7. Kliknij przycisk OK, aby zatwierdzić wprowadzone wartości. 
Po sprawdzeniu wsadu oprogramowanie Capture Pro wyświetli wszystkie 
obrazy spełniające ustalone kryteria (np. tylne strony o rozmiarze poniżej 
5000 bajtów) w oknie Remove Blank Images (Usuń puste obrazy). Obrazy 
te są podświetlone na czerwono. Wszystkie pokolorowane obrazy są 
uznane za puste i gotowe do usunięcia.

• Jeśli w oknie Remove Blank Images (Usuń puste obrazy) nie są 
wyświetlane żadne puste obrazy, oprogramowanie Capture Pro nie może 
znaleźć w danym wsadzie żadnych obrazów spełniających ustalone 
kryteria. Możesz kliknąć pozycję Setup (Konfiguracja) w oknie Remove 
Blank Images (Usuń puste strony), aby otworzyć ponownie okno 
dialogowe Remove Blank Images Setup (Konfiguracja usuwania pustych 
obrazów) i wprowadzić wyższy próg wielkości obrazu (w bajtach) dla 
obrazów czarno-białych i/lub kolorowych albo w skali szarości.

8. Domyślnie wszystkie puste obrazy są zaznaczone na czerwono i wybrane 
do usunięcia. Wybierz dowolne puste obrazy, których nie chcesz usunąć, 
klikając je indywidualnie. Czerwone zaznaczenie tych obrazów zostanie 
usunięte.

9. Za pomocą przycisków First Screen (Pierwszy ekran), Previous Screen 
(Poprzedni ekran), Next Screen (Następny ekran) i Last Screen (Ostatni 
ekran) możesz łatwo poruszać się po wszystkich możliwych do usunięcia 
pustych obrazach wsadu.

10. Kliknij przycisk Remove (Usuń). Zostanie wyświetlone okno dialogowe 
Remove all selected images? (Usunąć wszystkie zaznaczone obrazy?).

11. Kliknij przycisk Yes (Tak), aby potwierdzić usunięcie pustych obrazów. 
Oprogramowanie Capture Pro usunie puste obrazy nadal zaznaczone 
na czerwono, zaktualizuje numerację dokumentów oraz dostępną 
pojemność wsadu i dysku twardego.

Przetwarzanie wyjściowe 
wsadu

Po ukończeniu wszystkich czynności redakcyjnych wsad jest gotowy 
do przetwarzania wyjściowego.

Oprogramowanie Capture Pro umożliwia przetwarzanie wyjściowe 
poszczególnych wsadów kolejno lub wszystkich wsadów naraz. 
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Aby wykonać przetwarzanie wyjściowe bieżącego wsadu w konfiguracji zadania:
1. Wybierz kolejno Batch > Output (Wsad > Przetwarzanie wyjściowe). 

Gdy wsad trafi do kolejki oczekujących na przetwarzanie wyjściowe, 
zostanie wyświetlone okno dialogowe New Batch (Nowy wsad) 
umożliwiające skanowanie innego wsadu dokumentów. 
UWAGA: W przypadku licencji z grupy A i B na potrzeby przetwarzania 

wyjściowego wsadów należy podłączyć skaner fizyczny. 
W przypadku potrzeby przetworzenia wyjściowego wsadu bez 
podłączania skanera jest dostępna dodatkowo płatna licencja 
na indeksowanie.

2. Kliknij przycisk OK, aby kontynuować skanowanie obrazów do nowego 
wsadu. Wsad jest przetwarzany zgodnie z ustawieniem System Output 
Destination (Lokalizacja wyjściowa w systemie) wybranym na karcie 
Output (Przetwarzanie wyjściowe) okna dialogowego Job Setup 
(Konfiguracja zadania). Z reguły powoduje to skopiowanie wsadu 
do miejsca określonego przez ścieżkę podkatalogu wyjściowego.

Aby przetworzyć wyjściowo wszystkie wsady dostępne w danej w konfiguracji 
zadania:
• Wybierz kolejno Batch > Output All (Wsad > Przetwarzanie wyjściowe 

wszystkiego). Zostanie wyświetlone okno dialogowe Batch Manager 
(Menedżer wsadów), za pomocą którego można wybrać wsady 
do przetworzenia wyjściowego. 

Aby wyświetlić postęp przetwarzania wyjściowego:
• Wybierz kolejno Batch > View Batch Output Status (Wsad > Wyświetl stan 

przetwarzania wyjściowego wsadów). Zostanie wyświetlone okno Capture 
Pro Batch Process Status (Stan przetwarzania wsadów). 

W oknie na bieżąco będą wyświetlane informacje o postępie przetwarzania 
wsadów. Gdy w tle odbywa się przetwarzanie wyjściowe, skanowanie ma 
wyższy priorytet. Do ukończenia skanowania przetwarzanie wyjściowe 
może być wolniejsze.

Usuwanie błędów Okno stanu wsadów oprogramowania Capture Pro zawiera informacje 
o wsadach przygotowywanych do przetwarzania wyjściowego.

Aby wyświetlić okno Batch Status (Stan wsadów):

• Wybierz kolejno Batch > View Batch Output Status (Wsad > Wyświetl stan 
przetwarzania wyjściowego wsadów).

Aby usunąć błędy:

• Kliknij prawym przyciskiem myszy pozycję w kolumnie Batch Name (Nazwa 
wsadu) i wybierz polecenie Clear All Errors (Usuń wszystkie błędy) lub 
Clear Selected Errors (Usuń wybrane błędy).
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2   Interfejs użytkownika

W tym rozdziale przedstawiono okno główne programu Capture Pro, pasek 
menu, paski narzędzi i przeglądarki.

Okno główne Okno główne składa się z następujących elementów.

1 Pasek tytułowy programu — zawiera nazwę konfiguracji zadania.

2 Pasek menu — na tym pasku znajdują się następujące elementy menu: 
File (Plik), Batch (Wsad), View (Widok), Capture (Przechwytywanie), 
Document (Dokument), Edit (Edycja), Tools (Narzędzia), Index (Indeks) 
oraz Help (Pomoc).

3 Paski narzędzi — dostępne są następujące paski narzędzi: Capture 
(Przechwytywanie), Batch (Wsad), View (Widok), Document (Dokument), 
Navigation (Nawigacja), Flag (Flaga), Edit (Edycja) oraz Index (Indeks).

4 Batch Explorer (Eksplorator wsadów) — zawiera listę wszystkich 
folderów z dokumentami, stron i plików obrazów we wsadzie. 

5 Image Viewer (Przeglądarka obrazów) — wyświetla obrazy we wsadzie. 
Przeglądarkę obrazów można skonfigurować do równoczesnego 
wyświetlania 1, 2, 4, 8 lub więcej obrazów.

6 Thumbnail Viewer (Przeglądarka miniatur) — wyświetla miniatury 
wszystkich obrazów wsadu.
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7 Karta Index (Indeks) — kliknięcie tej karty (znajdującej się z prawej 
strony okna głównego) powoduje otwarcie okna indeksu, w którym są 
wyświetlane indeksy na poziomie wsadu lub dokumentu. 

8 Karta Information (Informacje) — kliknięcie tej karty (znajdującej się 
z prawej strony okna głównego) powoduje otwarcie okna, w którym są 
wyświetlane szczegółowe statystyki dotyczące wsadu, dokumentu, strony 
i obrazu.
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Pasek menu Pasek menu — na tym pasku znajdują się następujące elementy menu: 
File (Plik), Batch (Wsad), View (Widok), Capture (Przechwytywanie), 
Document (Dokument), Edit (Edycja), Tools (Narzędzia), Index (Indeks) 
oraz Help (Pomoc).

Menu File (Plik) Menu File (Plik) zawiera następujące opcje:

Job Setup (Konfiguracja zadania) — wyświetla okno dialogowe Job Setup 
(Konfiguracja zadania), które umożliwia ustawienie wszystkich parametrów 
konfiguracji zadania. Więcej informacji zawiera Podręcznik administratora 
oprogramowania Kodak Capture Pro. Skrót klawiaturowy: J.

Page Setup (Konfiguracja strony) — wyświetla okno dialogowe Page Setup 
(Konfiguracja strony), które umożliwia wybranie wstępnie zdefiniowanej 
konfiguracji strony lub utworzenie własnej konfiguracji strony dla konfiguracji 
zadania. Oprogramowanie Capture Pro jest dostarczane z kilkoma wstępnie 
zdefiniowanymi konfiguracjami strony. Lista zdefiniowanych konfiguracji strony 
różni się w zależności od używanego skanera. Więcej informacji na ten temat 
zawiera Podręcznik administratora.

Workstation Setup (Konfiguracja stacji roboczej) — wyświetla okno 
dialogowe Workstation Setup (Konfiguracja stacji roboczej), które umożliwia 
wybranie skanera podłączonego do komputera w celu skanowania 
dokumentów przy użyciu oprogramowania Capture Pro. Po uzyskaniu 
odpowiedniej licencji można także wybrać opcję Auto Import (Import 
automatyczny), aby obrazy były automatycznie importowane 
do oprogramowania Capture Pro. Informacje o procedurach zawiera: 
„Konfiguracja stacji roboczej” na stronie 21.

Intelligent Job Select (Inteligentny wybór zadań) — wyświetla okno 
dialogowe Intelligent Job Select (Inteligentny wybór zadań), które umożliwia 
używanie funkcji arkuszy kodów separujących do automatycznej zmiany 
konfiguracji zadania lub strony podczas skanowania. Więcej informacji na ten 
temat zawiera Podręcznik administratora.

Import Job Setup (Importuj konfigurację zadania) — wyświetla okno 
dialogowe Import (Importowanie), które umożliwia zaimportowanie konfiguracji 
zadania. Więcej informacji na ten temat zawiera Podręcznik administratora.

Export Job Setup (Eksportuj konfigurację zadania) — wyświetla okno 
dialogowe Export (Eksportowanie), które umożliwia wyeksportowanie 
konfiguracji zadania do pliku. Więcej informacji zawiera Podręcznik 
administratora oprogramowania Kodak Capture Pro.

User Setup (Konfiguracja użytkowników) — wyświetla okno dialogowe User 
Setup (Konfiguracja użytkowników), które umożliwia administratorowi 
skonfigurowanie użytkowników oprogramowania Capture Pro i zarządzanie 
nimi. Więcej informacji na ten temat zawiera Podręcznik administratora.

Change Password (Zmień hasło) — wyświetla okno dialogowe Change 
Password (Zmiana hasła), które umożliwia zmianę hasła.

Aby zmienić hasło:

1. Wybierz kolejno pozycje File > Change Password (Plik > Zmień hasło). 
Zostanie wyświetlone okno dialogowe Change Password (Zmiana hasła).

2. Wpisz stare hasło w polu Old Password (Stare hasło), następnie wpisz 
nowe hasło w polu New Password (Nowe hasło).

3. Potwierdź hasło, wpisując ponownie nowe hasło w polu Confirm Password 
(Potwierdź hasło).
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4. Kliknij przycisk OK. 

Language (Język) — umożliwia wybór języka interfejsu użytkownika. 
Obsługiwane języki: angielski, francuski, włoski, niemiecki, portugalski 
(Brazylia), holenderski, hiszpański, chiński uproszczony, chiński 
tradycyjny, szwedzki, koreański, turecki, czeski, rosyjski, arabski, polski 
i japoński.
Aby zmienić język:

1. Wybierz kolejno pozycje File > Language (Plik > Język). 

2. Wybierz żądany język. Interfejs użytkownika zostanie wyświetlony 
w wybranym języku.

UWAGA: W przypadku, gdy językiem domyślnym jest język zachodni, 
a użytkownik zmieni go na język azjatycki, tekst w oknie dialogowym 
Scanner Setup (Konfiguracja skanera) (sterownik TWAIN) może być 
wyświetlany nieprawidłowo. Aby rozwiązać ten problem, skorzystaj 
z ustawień systemowych „Opcje regionalne i językowe” i ustaw 
opcję „Język dla programów nieobsługujących kodu Unicode” 
na żądany język azjatycki.

Measurement System (System miar) — pozwala wybrać system miar US 
(amerykański) lub Metric (metryczny).

Print (Drukuj) —wyświetla okno dialogowe Print Setting (Ustawienia 
drukowania) dla wybranej drukarki, w którym można wydrukować 
zeskanowane dokumenty. Skrót klawiaturowy: Ctrl + P.

Save As PDF (Zapisz jako PDF) — wyświetla okno dialogowe Save as PDF 
(Zapisz jako PDF), które pozwala na zapisanie zeskanowanych obrazów 
w formacie PDF z możliwością wyszukiwania lub bez niej.

Logout  (Wyloguj) — umożliwia wylogowanie bieżącego użytkownika.

Minimize to System Tray (Zminimalizuj do paska zadań) — minimalizuje 
aplikację Capture Pro, jednak jej nie zamyka.

Exit (Wyjście) — zamyka oprogramowanie Capture Pro. Skrót klawiaturowy: 
Alt + F4.



A-61992_pl  marzec 2022 21

Konfiguracja stacji roboczej Po wybraniu pozycji File > Workstation Setup (Plik > Konfiguracja stacji 
roboczej) zostanie wyświetlony ekran Workstation Setup (Konfiguracja stacji 
roboczej). Z poziomu tego ekranu można skonfigurować parametry stacji 
roboczej i wybrać używany skaner.

1. Wprowadź niezbędne informacje o stacji roboczej w polach ID 
(Identyfikator) i Name (Nazwa). W środowisku wieloskanerowym 
identyfikator i nazwa skanera muszą być unikatowe.

2. Doświadczeni użytkownicy, którzy nie chcą korzystać z ekranu Szybki 
start, mogą wyczyścić pole wyboru Quick Start view (Widok Szybki start). 

3. Kliknij przycisk Select (Wybierz). Zostanie wyświetlone okno dialogowe 
Select Source (Wybierz skaner) z listą dostępnych skanerów i innych 
źródeł, takich jak Auto Import (Importowanie automatyczne), w zależności 
od posiadanej licencji. 

4. Zaznacz źródło do użycia i kliknij przycisk OK. 

5. W polu Disk Warning Level określ poziom zajętości dysku w megabajtach 
(MB) na potrzeby ostrzeżeń. Otrzymasz ostrzeżenie, jeśli ilość wolnego 
miejsca na dysku spadnie poniżej tego poziomu.
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6. Jeśli dla każdego zadania ma być prowadzona niezależna numeracja 
wsadów, zaznacz pole wyboru opcji Enable job level batch numbering 
(Włącz numerowanie wsadu na poziomie zadania). Jeżeli pole wyboru tej 
opcji jest zaznaczone, numerowanie będzie zachowywane na poziomie 
zadania. Jeżeli pole wyboru tej opcji nie jest zaznaczone, numerowanie 
będzie zachowywane na poziomie systemu. Przykład: 

7. Jeśli zaznaczysz opcję Display confirmation message during manual 
deletion (Wyświetl komunikat potwierdzenia przy usuwaniu ręcznym) 
i wpiszesz rozmiar strony w kilobajtach (KB), otrzymasz ostrzeżenie przy 
próbie usunięcia obrazu, którego rozmiar strony przekracza określoną 
wartość.

8. W sekcji Automatic restart limit (Limit restartu automatycznego) wpisz 
wartości w polach Restart Threshold (Próg) i Restart Offset 
(Przesunięcie restartu), jeśli chcesz, aby program Capture Pro 
automatycznie uruchamiał się ponownie po osiągnięciu tych limitów. 

Jeśli na przykład Restart Threshold (Próg restartu) = 5 i Restart Offset 
(Przesunięcie restartu) = 2, program Capture Pro uruchamia się ponownie 
po zeskanowaniu 7 stron w bieżącej sesji skanowania.

Po osiągnięciu progu restartu zostanie wyświetlone okno dialogowe 
Confirmation (Potwierdzenie) z informacją, że liczba zeskanowanych 
arkuszy osiągnęła limit progu oraz pytaniem, czy przed ponownym 
uruchomieniem kontynuować skanowanie aż do osiągnięcia liczby arkuszy 
określonej w przesunięciu. Kliknięcie Yes (Tak) spowoduje, że przed 
ponownym uruchomieniem programu Capture Pro zostaną zeskanowane 
kolejne 2 strony.

UWAGA: Zaleca się, aby próg restartu nie był większy niż 8000.

9. Kliknięcie No (Nie) spowoduje, że program Capture Pro natychmiast 
uruchomi się ponownie, a opcja Automatic restart limit (Limit restartu 
automatycznego) zostanie wyszarzona po wznowieniu skanowania.

Menu Wsad Menu Batch (Wsad) zawiera następujące opcje:

New (Nowy) — wyświetla okno dialogowe New Batch (Nowy wsad), 
które umożliwia utworzenie nowego wsadu.

Open (Otwórz) — wyświetla okno dialogowe Batch Manager (Menedżer 
wsadów) umożliwiające otwarcie istniejącego wsadu. Skrót klawiaturowy: F3. 
Informacje o procedurach zawiera: „Rozpoczęcie pracy” na stronie 1.

Close (Zamknij) — zamyka obecnie otwarty wsad.

Rename (Zmień nazwę) — wyświetla okno dialogowe Rename Batch (Zmiana 
nazwy wsadu) umożliwiające zmianę nazwy bieżącego wsadu.

Remove Blank Images (Usuń puste obrazy) — wyświetla okno dialogowe 
Remove Blank Images Setup (Konfiguracja usuwania pustych obrazów) 
umożliwiające usuwanie pustych obrazów z przodu lub tyłu utworzonych przez 
skaner. Skrót klawiaturowy: K. Informacje o procedurach zawiera: 
„Rozpoczęcie pracy” na stronie 1.

Poziom systemu Poziom zadania
Faktury FAV001 Faktury FAV001
Reklamacje REK002 Reklamacje REK001
Akta AKT003 Akta AKT001
Faktury FAV004 Faktury FAV002
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Output (Przetwarzanie wyjściowe) — uruchamia przetwarzanie wszystkich 
obrazów z bieżącego wsadu. Skrót klawiaturowy: O. Informacje o procedurach 
zawiera: „Rozpoczęcie pracy” na stronie 1.

UWAGA: W przypadku licencji z grupy A i B na potrzeby przetwarzania 
wyjściowego wsadów należy podłączyć skaner fizyczny. 
W przypadku potrzeby przetworzenia wyjściowego wsadu bez 
podłączania skanera jest dostępna dodatkowo płatna licencja 
na indeksowanie.

Output All (Przetwarzanie wyjściowe wszystkiego) — uruchamia 
przetwarzanie wszystkich obrazów ze wszystkich wsadów należących 
do bieżącego zadania. 

View Batch Output Status (Wyświetl stan przetwarzania wyjściowego 
wsadów) — wyświetla okno Capture Pro Batch Process Status (Stan 
przetwarzania wsadów oprogramowania Capture Pro), które zawiera 
informacje o postępie przetwarzania wyjściowego wsadów. Patrz „Okno stanu 
przetwarzania wsadu” na stronie 49.

Clear (Wyczyść) — usuwa wszystkie obrazy z wsadu, pozostawiając strukturę 
podkatalogów wsadu bez zmian.

Delete (Usuń) — usuwa zarówno obrazy, jak i całą strukturę podkatalogów 
wybranego wsadu. Informacje o procedurach zawiera: „Rozpoczęcie pracy” na 
stronie 1.

Delete to End of Batch (Usuń do końca wsadu) — usuwa wszystkie obrazy 
od zaznaczonego obrazu do ostatniego obrazu we wsadzie.
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Menu Widok Menu View (Widok) zawiera następujące opcje:

Image Viewer Display (Tryb wyświetlania w przeglądarce obrazów) — 
umożliwia wybranie siatki 1, 2, 4 lub 8 obrazów do wyświetlenia w oknie 
głównym. Wybranie opcji Customize (Dostosuj) spowoduje wyświetlenie okna 
dialogowego Custom Layout Setup (Konfiguracja układu niestandardowego), 
które umożliwia określenie innej siatki wyświetlania.

Image Viewer Filter (Filtr przeglądarki obrazów) — pozwala określić jeden lub 
więcej rodzajów obrazów do wyświetlenia w panelu Image Viewer 
(Przeglądarka obrazów) okna głównego. Wybierz jedną lub więcej 
z następujących opcji: Front (Przód), Back (Tył), Black & White (Czarno-
biały), Grayscale (Skala szarości) oraz Color (Kolor).

Thumbnail Viewer Filter (Filtr przeglądarki miniatur) — pozwala określić 
jeden lub więcej rodzajów obrazów do wyświetlenia w panelu Thumbnail 
Viewer (Przeglądarka miniatur) okna głównego. Wybierz co najmniej jeden 
z następujących filtrów: Front (Przód), Back (Tył), Black & White (Czarno-
biały), Grayscale (Skala szarości) oraz Color (Kolor).

Thumbnail Image Size (Rozmiar miniatur) — wyświetla okno dialogowe 
Thumbnail Image Size Setup (Konfiguracja rozmiaru miniatur) umożliwiające 
określenie rozmiaru każdej miniatury wyświetlanej w oknie głównym.

Image Viewer (Przeglądarka obrazów), Batch Explorer (Eksplorator 
wsadów), Thumbnail Viewer (Przeglądarka miniatur), Information 
(Informacje), Index (Indeks), Status Bar (Pasek stanu) — te polecenia służą 
do wyboru opcji wyświetlania odpowiednich elementów w oknie głównym. 
Skrót klawiaturowy wyświetlenia paska stanu to Ctrl + S.

Toolbars (Paski narzędzi) — umożliwia wyświetlanie i ukrywanie 
następujących pasków narzędzi: Capture (Przechwytywanie), Batch (Wsad), 
View (Widok), Document (Dokument), Navigation (Nawigacja), Flag (Flaga), 
Edit (Edycja) oraz Index (Indeks). Szczegółowe informacje dotyczące pasków 
narzędzi zamieszczono w dalszej części tego rozdziału.

Icon Size (Rozmiar ikon) — dostępne opcje to Small (Małe), Medium 
(Średnie) lub Large (Duże).

Icon Text (Tekst ikon) — pozwala włączyć opcję wyświetlania etykiet ikon 
i wybrać ich umiejscowienie: z prawej strony lub poniżej ikon.

Zoom — służy do powiększania i pomniejszania rozmiaru wyświetlanego 
obrazu. 

• Actual (Rozmiar rzeczywisty): wyświetla obraz w rozmiarze rzeczywistym 
(jeden zeskanowany piksel to jeden piksel w przeglądarce obrazów).

• Zoom In (Powiększenie): zwiększa rozmiar wyświetlanego obrazu 
ze skokiem określonym w oknie dialogowym Zoom Step Setup 
(Konfiguracja skoku powiększenia/pomniejszenia).

• Zoom Out (Pomniejszenie): zmniejsza rozmiar wyświetlanego obrazu 
ze skokiem określonym w oknie dialogowym Zoom Step Setup 
(Konfiguracja skoku powiększenia/pomniejszenia).

• Zoom Step (Skok powiększenia): wyświetla okno dialogowe Zoom Step 
Setup (Konfiguracja skoku powiększenia/pomniejszenia) (15%, 20%, 25%, 
30%, 35% lub 40%) pozwalające wybrać wartość procentową, o którą 
zmienia się rozmiar obrazu w przypadku użycia poleceń powiększenia 
i pomniejszenia.
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Pan All Images to (Przesuń wszystkie obrazy) — umożliwia jednoczesne 
przesunięcie wszystkich obrazów w panelu Image Viewer (Przeglądarka 
obrazów). Obrazy można przesuwać w górę (Top), dół (Bottom), w lewo (Left) 
lub w prawo (Right).

Pan Step Setup (Konfiguracja skoku przesunięcia) — wyświetla okno 
dialogowe Pan Step Setup (Konfiguracja skoku przesunięcia) służące do 
określenia liczby pikseli (5, 10, 15, 25, 50 lub 100), o którą obrazy zostaną 
przesunięcie w przypadku użycia poleceń Pan (Przesuń).

Layout (Układ) — pozwala wybrać układ Classic (Klasyczny) i Enhanced 
(Zaawansowany).

Szybki start (Quick start) — zawiera menu najczęściej używanych funkcji 
i kafelków zadań.

Menu Przechwytywanie Menu Capture (Przechwytywanie) zawiera następujące opcje:

Start — służy do włączania skanera i uruchamiania transportu. Skrót 
klawiaturowy: F7.

Stop — służy do zatrzymywania transportu i wyłączania skanera. Skrót 
klawiaturowy: F6.

Page Setup List (Lista konfiguracji strony) — wyświetla okno dialogowe Page 
Setup List (Lista konfiguracji strony) umożliwiające wybór jednej 
ze zdefiniowanych konfiguracji. Skrót klawiaturowy: F2.

Capture modes (Tryby przechwytywania) — określa sposób, w jaki wsad jest 
skanowany, umożliwiając wybranie jednego z poniższych ustawień.
• Two Sided (Dwustronnie): skanowanie strony z przodu i z tyłu.
• One-Sided Front (Jednostronnie — strona przednia): skanowanie strony 

wyłącznie z przodu.
• One-Sided Back (Jednostronnie — strona tylna): skanowanie strony 

wyłącznie z tyłu.

Select Scanner (Wybierz skaner) — wyświetla okno dialogowe Workstation 
Setup (Konfiguracja stacji roboczej) umożliwiające wybranie żądanego 
skanera.

Manual Import Images (Ręczne importowanie obrazów) — umożliwia 
importowanie plików obrazu pochodzących z innego źródła (np. skanera 
projektów technicznych) do dokumentu obecnie wyświetlanego w programie 
Capture Pro. 

Wybranie opcji Manual Import Images (Ręczne importowanie obrazów) 
spowoduje wyświetlenie okna dialogowego Open (Otwórz). Przejdź do folderu, 
do którego mają być importowane obrazy, i wybierz żądane pliki obrazów. 
Można importować pliki obrazów w formacie BMP, JPEG, PDF, TIFF, IOCA, 
MODCA, GIF, CMP i PNG. Obrazy wybrane do importowania zostaną 
wstawione bezpośrednio przed obrazem zaznaczonym w obecnie 
wyświetlanym dokumencie. Jeśli nie ma zaznaczonych obrazów, 
zaimportowane obrazy zostaną dołączone na końcu bieżącego dokumentu.

W przypadku plików TIFF obsługiwane są zarówno pliki jednostronicowe, 
jak i wielostronicowe. W przypadku importowania wielostronicowego pliku 
TIFF każdy obraz w pliku zostanie zaimportowany do dokumentu jako 
oddzielny obraz.

Do importowania można wybrać więcej niż jeden plik obrazu. W przypadku 
wybrania więcej niż jednego pliku obrazy zostaną zaimportowane w porządku 
alfabetycznym/liczbowym zgodnie z nazwą pliku obrazu.
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View Pending Auto-Import Tasks (Wyświetl oczekujące zadania importu 
automatycznego) — wyświetla tabelę z wszystkimi nieukończonymi jeszcze 
zadaniami automatycznego importowania wysłanymi do programu Capture 
Pro przy użyciu interfejsu API (application programming interface) 
importowania automatycznego. 

Auto Import Setup (Konfiguracja importowania automatycznego) — 
wyświetla okno dialogowe Auto Import Setup (Konfiguracja importowania 
automatycznego) umożliwiające skonfigurowanie „folderów obserwowanych” 
funkcji importowania automatycznego. W oknie dialogowym Auto Image Setup 
(Konfiguracja automatycznego zarządzania obrazami) można zidentyfikować 
foldery obserwowane i przypisać im przyjazne nazwy. Można również określić 
foldery przeznaczone do archiwizacji i obsługi błędów, przypisać poziomy 
progów błędów oraz określić reguły separacji wsadów funkcji importowania 
automatycznego i przedziały czasowe. Więcej informacji na ten temat zawiera 
Podręcznik administratora oprogramowania Kodak Capture Pro.

Set Image Address (Ustaw adres obrazu) — wyświetla okno dialogowe 
Image Address (Adres obrazu), które umożliwia zmianę ustawień adresu 
obrazu dla danego wsadu. Opcja ta jest aktywna wyłącznie w przypadku 
skanerów wyposażonych w funkcję adresowania obrazów.

Set Counter (Ustaw licznik) — wyświetla okno dialogowe Set Counter (Ustaw 
licznik) umożliwiające zerowanie kolejnej wartości licznika przypisywanej 
(i opcjonalnie drukowanej) do następnej zeskanowanej strony. Opcja ta jest 
aktywna wyłącznie w przypadku skanerów wyposażonych w licznik.

Menu Dokument Menu Document (Dokument) zawiera następujące opcje:

New (Nowy) — tworzy nowy dokument o numerze równym numerowi 
ostatniego dokumentu powiększonemu o „1”. Skrót klawiaturowy: Ctrl + Enter.

UWAGA: W przypadku niektórych skanerów wybranie opcji New (Nowy) 
powoduje również włączenie skanera i uruchomienie transportu/
podajnika skanera lub skanera płaskiego.

Attach Page (Dołącz stronę) — umożliwia zeskanowanie dodatkowych 
obrazów i dołączenie ich jako stron do istniejącego dokumentu. Skrót 
klawiaturowy: F4.

Insert Pages (Wstaw strony) — wstawia dodatkowe strony do 
zeskanowanego dokumentu. Skrót klawiaturowy: Insert.

UWAGA: W przypadku włączenia funkcji adresu obrazu i wykrywania 
separatora polecenie Insert Pages (Wstaw strony) nie spowoduje 
rozdzielenia dokumentu w razie wykrycia separatora dokumentu. 

Rescan Pages (Zeskanuj strony ponownie) — uruchamia skaner i zastępuje 
wybrane strony nowo zeskanowanymi stronami. Skrót klawiaturowy: R.

Split Document (Podziel dokument) — dzieli bieżący dokument na dwa 
dokumenty w miejscu określonym przez wybraną stronę.

Merge into Previous (Połącz z poprzednim) — wstawia obecnie skanowany 
dokument do poprzedniego dokumentu.

Delete (Usuń) — usuwa obecnie otwarty dokument. Skrót klawiaturowy: F8.

Delete Range (Usuń zakres) — wyświetla okno dialogowe Delete Documents 
in Range (Usuń dokumenty z zakresu), co pozwala usunąć dany zakres 
dokumentów z wsadu.
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Delete to End of Document (Usuń do końca dokumentu) — umożliwia 
usunięcie wybranego obrazu i wszystkich kolejnych obrazów z dokumentu. 
Za pomocą tego polecenia usuwa się obrazy z dysku twardego. Funkcji tej nie 
można cofnąć.

Go to Document (Przejdź do dokumentu) — umożliwia wybranie opcji 
przejścia do pierwszego, ostatniego, następnego lub poprzedniego 
dokumentu we wsadzie. Można też wybrać opcję Document Number 
(Numer dokumentu), aby przejść do konkretnego dokumentu we wsadzie.

Go to Image (Przejdź do obrazu) — otwiera okno dialogowe Go to Image 
(Przejdź do obrazu) pozwalające wyszukać żądany obraz w bieżącym 
dokumencie. Skrót klawiaturowy: I.

Menu Edycja Menu Edit (Edycja) zawiera następujące opcje:

Undo (Cofnij) — przywraca jeden poziom ostatniego działania. Jeśli 
przywrócenie stanu nie będzie możliwe, zostanie wyświetlony komunikat. 
Skrót klawiaturowy: Ctrl + Z.

Copy (Kopiuj) — kopiuje wybrany obraz w celu wklejenia w innej lokalizacji. 
Skrót klawiaturowy: Ctrl + C.

Copy Image Area (Kopiuj obszar obrazu) — ta opcja służy do skopiowania 
obszaru utworzonego przy użyciu narzędzia Draw Region (Rysuj obszar) do 
innej lokalizacji. Skrót klawiaturowy: Ctrl + I.

Copy Image to Job Setup (Kopiuj obraz do konfiguracji zadania) — wyświetla 
okno dialogowe Copy Image to Job Setup (Kopiuj obraz do konfiguracji 
zadania), które umożliwia importowanie obrazów do okna Bar Code (Kod 
kreskowy) lub okna OCR w celu utworzenia strefy kodu kreskowego lub OCR.

Select All (Zaznacz wszystkie) — zaznacza wszystkie obrazy w bieżącym 
wsadzie. Skrót klawiaturowy: Ctrl + A.

Select Document (Zaznacz dokument) — zaznacza wszystkie obrazy 
w bieżącym dokumencie.

Select Filtered (Zaznacz filtrowane) — zaznacza wszystkie obrazy, dla 
których wybrano parametry filtrowania.

Deselect All (Anuluj zaznaczenie wszystkich) — anuluje zaznaczenie 
wszystkich obrazów. Skrót klawiaturowy: Ctrl + D.

Select Flagged (Zaznacz oflagowane) — zaznacza wszystkie obrazy 
z flagami. Skrót klawiaturowy: Ctrl + F.

Delete (Usuń) — usuwa wybrane obrazy z wsadu. Skrót klawiaturowy: Del.
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Menu Narzędzia Menu Tools (Narzędzia) zawiera następujące opcje:

Selector (Narzędzie wyboru) — wyświetla narzędzie Pointer (Wskaźnik), który 
pozwala wybierać obrazy. Obrazy można wybierać również za pomocą 
narzędzia Magnify (Lupa). Patrz opis narzędzia Magnify (Lupa) poniżej. 
Skrót klawiaturowy: S.

Selection mode (Tryb wyboru) — wybierz Image (Obraz), Page (Strona) lub 
Page Side (Przód/tył strony). 

• W przypadku wyboru opcji Image (Obraz) można kliknąć obraz w panelu 
Image Viewer (Przeglądarka obrazów), co spowoduje zaznaczenie 
żądanego obrazu.

• W przypadku wyboru opcji Page (Strona) kliknięcie obrazu spowoduje 
zaznaczenie całej strony, jej przodu i tyłu, strony czarno-białej i kolorowej/
w skali szarości.

• W przypadku skanowania wielu obrazów na jedną stronę (skanowanie 
dwustrumieniowe) wybranie opcji Page Side (Przód/tył strony) i kliknięcie 
obrazu z przodu spowoduje zaznaczenie wszystkich obrazów przednich. 
Kliknięcie obrazu tylnego spowoduje zaznaczenie wszystkich obrazów 
spodnich.

Magnify (Lupa) — powiększa część obrazu. Wybranie ikony Magnify (Lupa) 
spowoduje wyświetlenie narzędzia Magnify (Lupa). Umieszczenie narzędzia 
lupy w dowolnym miejscu obrazu spowoduje powiększenie tego obszaru. 
(Aby powiększyć obraz, kliknij i przytrzymaj lewy przycisk myszy. Kliknięcie 
lewym przyciskiem myszy spowoduje wybranie obrazu). Skrót klawiaturowy: M.

Pan (Przesuń) — pozwala przesunąć obraz w panelu Image Viewer 
(Przeglądarka obrazów), gdy obraz jest większy od panelu. Skrót 
klawiaturowy: P. Kliknięcie lewym przyciskiem myszy spowoduje wybranie 
obrazu.

Draw Region (Rysuj obszar) – umożliwia zaznaczenie prostokątnego 
fragmentu obrazu i usunięcie jego zawartości za pomocą polecenia Blank 
(Wyczyść) lub przycięcie obrazu do wielkości prostokąta za pomocą polecenia 
Crop (Przytnij) albo skopiowanie go przy użyciu polecenia Edit > Copy Image 
Area (Edytuj > Kopiuj obszar obrazu).

Magnification Ratio (Współczynnik powiększenia) — wyświetla okno 
dialogowe Magnification Ratio Setup (Konfiguracja współczynnika 
powiększenia) umożliwiające wybranie odpowiedniego stopnia powiększenia: 
100%, 150%, 200%, 250% lub 300%.

Aby powiększyć istniejący obraz w panelu Image Viewer (Przeglądarka 
obrazów) lub Thumbnail Viewer (Przeglądarka miniatur):

1. Wybierz kolejno pozycje Tools > Magnify (Narzędzia > Lupa).

2. Kliknij obraz, następnie przytrzymaj i przeciągnij narzędzie Magnify (Lupa) 
na obraz.

Rotate (Obróć) — ręcznie obraca zaznaczony obraz o 90, 180 lub 270 stopni 
w prawo. Oprogramowanie Capture Pro umożliwia automatyczne obracanie 
obrazów w trakcie procesu skanowania lub obracanie ręczne po zakończeniu 
skanowania.

Intelligent QC — uruchamia narzędzie Intelligent QC. Wszystkie zaznaczone 
obrazy będą dostępne do przeglądania i przetwarzania. Jeśli nie wybrano 
żadnego obrazu, będą dostępne wszystkie obrazy oznaczone flagą. Narzędzie 
Intelligent QC można też uruchomić, klikając prawym przyciskiem myszy obraz 
w panelu Image Viewer (Przeglądarka obrazów) lub Batch Explorer (Eksplorator 
wsadów) i wybierając pozycję Intelligent QC z wyświetlonej listy. Więcej 
informacji zawiera „Okno dialogowe narzędzia Intelligent QC” na stronie 29.
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Opcje narzędzia Flag (Flaga) — umożliwiają oznaczenie flagą obrazów, które 
mogą wymagać ponownego zeskanowania lub dostosowania (np. 
dostosowania kontrastu w celu uzyskania lepszej jakości obrazu). Skrót 
klawiaturowy: C.

• Flag Tool (Narzędzie Flaga): umożliwia oznaczenie flagą strony, obrazu lub 
zarówno przodu jak i tyłu obrazu.

• Flag All Selected (Oznacz wszystkie zaznaczone): wszystkie zaznaczone 
obrazy ze wsadu zostaną oznaczone flagą do ponownego skanowania.

• Flag Document (Oznacz dokument): oznaczone zostaną wszystkie obrazy 
w zaznaczonym dokumencie.

• Flag Filtered (Oznacz filtrowane): umożliwia zastosowanie filtru do 
obrazów obecnie wyświetlanych w oknie Image Viewer (Przeglądarka 
obrazów). Po wybraniu przeglądarki, do której ma być zastosowany filtr, 
można wybrać opcję obrazów: Front Side (Przód) lub Back Side (Tył), 
Black and White (Czarno-biały), Grayscale (Skala szarości) lub Color 
(Kolor).

• Unflag All Selected (Usuń flagi wszystkich zaznaczonych): usuwa flagi 
z obecnie zaznaczonych obrazów.

• Unflag All (Usuń wszystkie flagi): usuwa wszystkie flagi z bieżącego wsadu. 

Split Document (Podziel dokument) — dzieli dokument na dwa odrębne 
dokumenty.

Crop (Przytnij) — umożliwia odcięcie obszaru znajdującego się poza 
prostokątem utworzonym za pomocą opcji Draw Region (Rysuj obszar). 
Po wybraniu tej opcji zostanie wyświetlone okno z potwierdzeniem. 
Skrót klawiaturowy: Ctrl + R. 

Blank (Wyczyść) — umożliwia wyczyszczenie obszaru znajdującego się 
wewnątrz prostokąta utworzonego za pomocą opcji Draw Region (Rysuj 
obszar). Po wybraniu tej opcji zostanie wyświetlone okno z potwierdzeniem. 
Skrót klawiaturowy: Ctrl + B. 

Mark As Blank (Oznacz jako pusty) — oznacza obrazy jako puste po 
wybraniu tej opcji z menu Tools (Narzędzia) lub kliknięciu obrazu prawym 
przyciskiem myszy. Obraz oznaczony jako pusty jest wyróżniany 
ciemnoniebieską ramką. Wybór tego polecenia dla już oznaczonego obrazu 
powoduje anulowanie oznaczenia. Polecenie jest dostępne tylko po włączeniu 
opcji „Keep blank images” (Zachowaj puste obrazy) w obszarze „Auto Delete” 
(Usuwanie automatyczne) wybranej konfiguracji strony.

Okno dialogowe narzędzia 
Intelligent QC

Wybranie ikony Intelligent QC na pasku narzędzi Edit (Edycja) powoduje 
uruchomienie narzędzia Intelligent QC. Wszystkie zaznaczone obrazy będą 
dostępne do przeglądania i przetwarzania. Jeśli nie wybrano żadnego obrazu, 
będą dostępne wszystkie obrazy oznaczone flagą. Narzędzie Intelligent QC 
można też uruchomić, klikając prawym przyciskiem myszy obraz w panelu 
Image Viewer (Przeglądarka obrazów) lub Batch Explorer (Eksplorator 
wsadów) i wybierając pozycję Intelligent QC z wyświetlonej listy.
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Narzędzie Intelligent QC nie jest dostępne podczas skanowania, ponownego 
skanowania lub gdy funkcja Auto Import (Importowanie automatyczne) 
monitoruje aktywny folder w oczekiwaniu na pliki obrazów.

Po włączeniu tego narzędzia w lewym panelu obrazu zostanie wyświetlony 
pierwszy obraz. Lewy panel będzie pokazywać obraz bez żadnego 
dodatkowego przetwarzania.

Prawy panel będzie wyświetlał obraz po zastosowaniu wybranych opcji 
przetwarzania.

Obraz można edytować, klikając wybrane ikony narzędzi przetwarzania 
obrazu znajdujące się pomiędzy panelami obrazu. Aby anulować określoną 
funkcję przetwarzania obrazu, kliknij ponownie wybrane narzędzie, co 
spowoduje anulowanie jego zaznaczenia.

Niektóre narzędzia przetwarzania obrazu mają dodatkowe elementy 
sterowania umożliwiające dostosowanie wyglądu obrazu. Na przykład 
narzędzie Binarize (Binaryzacja) ma kontrolkę dostosowania kontrastu. 
Dostosowanie kontrastu pozwoli uwidocznić bardzo jasny tekst przy 
utrzymaniu szumu tła na akceptowalnym poziomie.

Apply settings to next image (Zastosuj ustawienia do następnego obrazu) — 
w przypadku zaznaczenia tej opcji wybrane narzędzia przetwarzania obrazu 
oraz ich ustawienia zostaną zastosowane do kolejnego obrazu. W przypadku 
wybrania narzędzia Binarize (Binaryzacja), gdy kolejnym obrazem jest obraz 
czarno-biały, binaryzacja nie zostanie zastosowana. Jeżeli jednak włączono 
również narzędzie Hole Fill (Wypełnianie otworów), efekt ten zostanie 
zastosowany do obrazu czarno-białego. 

Apply To All (Zastosuj do wszystkich) — spowoduje zastosowanie wybranych 
narzędzi przetwarzania obrazu do wszystkich obrazów zaznaczonych za 
pomocą narzędzia Intelligent QC.

Next (Następny) — jeśli są dostępne kolejne obrazy do podglądu, zostanie 
wyświetlony przycisk Next (Następny). Kliknięcie przycisku Next (Następny) 
spowoduje zapisanie bieżącego obrazu w takim stanie, w jakim jest on 
wyświetlany w prawym panelu obrazu. W przypadku zaznaczenia opcji Apply 
to Next (Zastosuj do następnego) wybrane narzędzia przetwarzania obrazu 
zostaną zastosowane do następnego obrazu. Obraz przed przetworzeniem 
zostanie wyświetlony w lewym panelu obrazu, a obraz przetworzony — 
w prawym panelu. 
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Back (Poprzedni) — pokazuje poprzednio wyświetlany obraz. Wszystkie 
wybrane narzędzia zostaną wyłączone, a zaznaczenie opcji Apply to Next 
(Zastosuj do następnego) zostanie anulowane. Obraz zostanie wyświetlony 
w takim stanie, w jakim był, gdy naciśnięto przycisk Next (Następny).

View B&W / View Grayscale / Color (Wyświetl obraz czarno-biały / w skali 
szarości / kolorowy) — w przypadku gdy są dostępne obrazy w skali szarości/
kolorowe i powiązane obrazy czarno-białe (skanowanie dwustrumieniowe), 
w lewym panelu obrazu zostanie wyświetlony obraz czarno-biały. Aby 
wyświetlić obraz w skali szarości / kolorowy, kliknij przycisk View Grayscale/
Color (Wyświetl obraz w skali szarości / kolorowy).

Menu Indeks Menu Index (Indeks) zawiera następujące opcje:

Edit Index Fields (Edytuj pola indeksu) — zapewnia dostęp do pól indeksu na 
poziomie wsadu i dokumentu. Skrót klawiaturowy: E.

UWAGA: W przypadku licencji z grupy A i B na potrzeby edycji pól indeksu 
należy podłączyć skaner fizyczny. Gdy jest potrzebne 
przeprowadzenie indeksowania bez podłączania skanera, dostępna 
jest dodatkowo płatna licencja na indeksowanie.

Previous Document (Poprzedni dokument) — wyświetla informacje indeksu 
dotyczące poprzedniego dokumentu. Skrót klawiaturowy: F9.

Next Document (Następny dokument) — wyświetla informacje indeksu 
dotyczące następnego dokumentu. Skrót klawiaturowy: F10.

Next Invalid (Następny nieprawidłowy) — wyświetla informacje indeksu 
dotyczące następnego dokumentu z nieprawidłowym indeksem. Skrót 
klawiaturowy: F11.

Index1 (Indeks 1) — umożliwia wskazanie, że wsad jest gotowy do 
indeksowania.

Index2 (Indeks 2) — umożliwia wskazanie, że wsad jest gotowy do drugiego 
indeksowania w przypadku korzystania z funkcji Double Data Entry 
(Podwójne wprowadzanie danych).

UWAGA: W przypadku korzystania z funkcji Double Data Entry (Podwójne 
wprowadzanie danych): jeżeli operator przechwytywania 
wprowadza również wartości pierwszego indeksu, należy najpierw 
wybrać pozycję Index1, a pozycję Index2 wybrać dopiero wtedy, 
gdy wsad jest gotowy do drugiego wprowadzania wartości indeksu. 
Więcej informacji na temat podwójnego wprowadzania danych 
zawiera: „Korzystanie z funkcji Double Data Entry (Podwójne 
wprowadzanie danych)” na stronie 33.

Define Enter Key Behavior (Określ działanie klawisza Enter) — umożliwia 
przypisanie działania wykonywanego przez oprogramowanie po naciśnięciu 
klawisza Enter. Dostępne opcje: go to the Next Document (przejdź do 
następnego dokumentu), go to the Next Invalid document (przejdź do 
następnego nieprawidłowego dokumentu) lub Save & Exit Indexing (zapisz 
i zamknij okno indeksowania).

Zoom Zones (Strefy powiększenia) — narzędzie pozwalające narysować 
prostokąt obejmujący wybrany obszar obrazu, który ma zostać powiększony 
na ekranie podczas edytowania pól indeksu. Jest to ustawienie zapisywane 
niezależnie dla każdego pola indeksu. W efekcie można zdefiniować strefę 
powiększenia dla każdego pola indeksu. Odpowiedni fragment zostanie 
automatycznie powiększony podczas edycji powiązanego pola.
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Drag-and-Drop OCR (OCR typu przeciągnij i upuść) — umożliwia 
wypełnienie pola indeksu przez narysowanie obszaru obrazu. W wybranym 
obszarze zostanie uruchomiona funkcja OCR, a uzyskana wartość zostanie 
automatycznie wstawiona do odpowiedniego pola indeksu. Po wybraniu tego 
narzędzia narysuj prostokąt wokół danych indeksu do przechwycenia. 

UWAGA: Aby prawidłowo utworzyć wersję OCR dla znaków specyficznych dla 
danego języka (np. « lub ¸) albo znaków w kodowaniu MICR, 
wybierz odpowiedni język lub czcionkę MICR z listy rozwijanej.

One click OCR (OCR jednym kliknięciem) — pozwala kliknąć wyraz lub 
wartość, aby ustawić wybrane pole indeksu. Aby dołączyć więcej wyrazów lub 
wartości, naciśnij klawisz Ctrl, a następnie klikaj dodatkowe wyrazy lub wartości.

OCR Language (Język OCR) — umożliwia konfigurację języka używanego 
przez funkcję OCR. 

Save & Exit Indexing (Zapisz i zamknij okno indeksowania) — powoduje 
opuszczenie trybu indeksowania i zapisuje wszystkie zmiany wprowadzone 
we wsadzie. Skrót klawiaturowy: F12.

Cancel & Exit Indexing (Anuluj i zamknij okno indeksowania) — powoduje 
opuszczenie trybu indeksowania bez zapisywania wprowadzonych zmian. 
Skrót klawiaturowy: Esc.

Korzystanie z funkcji 
przeszukiwania bazy danych

Po przeprowadzeniu skanowania i przejściu w tryb indeksowania (Index > 
Edit Index Fields [Indeks > Edytuj pola indeksu]) każde przejście do 
dokumentu w trybie indeksowania spowoduje uruchomienie funkcji 
przeszukiwania na tym dokumencie.

W przypadku, gdy pole indeksu używane przez funkcję Lookup 
(Przeszukiwanie) już ma wprowadzoną wartość (np. z kodu kreskowego lub 
strefy OCR), funkcja Lookup (Przeszukiwanie) będzie uruchamiana 
automatycznie po przejściu do dokumentu.

W przypadku ręcznego wprowadzenia danych w polu indeksu funkcja Lookup 
zostanie uruchomiona, gdy użytkownik opuści pole indeksu. Użycie klawisza 
Tab w celu wyjścia z edytowanego pola indeksu spowoduje wyświetlenie 
wyników wypełniania pozostałych pól indeksu w celu ich weryfikacji. Użycie 
klawisza Enter lub innego klawisza funkcyjnego przydatnego w trybie 
indeksowania (tj. F9, F10, F11) w celu przejścia do innego dokumentu 
spowoduje uruchomienie funkcji Lookup (Przeszukiwanie) i wypełnienie 
pozostałych pól indeksu. Nie można jednak wyświetlić wyników działania 
funkcji Lookup (Przeszukiwanie), gdy dokument nie jest już wyświetlany 
w trybie indeksowania.

Jeśli pole Lookup (Przeszukiwanie) jest wypełnione za pomocą funkcji Drag n’ 
Drop OCR (OCR typu przeciągnij i upuść), funkcja Lookup (Przeszukiwanie) 
zostanie uruchomiona niezwłocznie i zostaną wyświetlone wyniki wypełnienia 
pozostałych pól w celu ich weryfikacji.

Jeśli wartość używana przez funkcję Lookup jest znana tylko częściowo, 
można skorzystać z symbolu gwiazdki (*) w celu zastąpienia nieznanych 
znaków. Znak gwiazdki musi być ostatnim znakiem w ciągu. Jeśli na przykład 
wartość funkcji Lookup (Przeszukiwanie) to numer telefonu, jednak czytelne 
są tylko pierwsze cztery cyfry, można wprowadzić wartość „557-3*”. W bazie 
danych zostaną wyszukane wszystkie numery telefoniczne rozpoczynające 
się od frazy „557-3xx....” i użytkownik będzie mógł wybrać właściwą wartość.
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Jeżeli przeszukiwanie jest oparte na dwóch wartościach, a znana jest tylko 
jedna z nich, zamiast nieznanej wartości można użyć symbolu gwiazdki. 
Przykład: funkcja Lookup (Przeszukiwanie) jest oparta na wartościach 
Nazwisko ORAZ Imię, a przeszukiwanie dotyczy adresu. Jeśli znane jest 
wyłącznie nazwisko, wprowadza się je w polu indeksu „Last Name” 
(Nazwisko), a w polu „First Name” (Imię) wprowadza się symbol gwiazdki. 
Jeśli dla wprowadzonego nazwiska zostanie znaleziony tylko jeden rekord, 
pola imienia i adresu zostaną wypełnione automatycznie. W przypadku 
znalezienie dla danego nazwiska więcej niż jednego rekordu zostanie 
wyświetlone okno dialogowe Multiple Results (Wiele wyników), które 
umożliwia użytkownikowi wybór odpowiedniej pozycji. 

Korzystanie z funkcji Double 
Data Entry (Podwójne 
wprowadzanie danych) 

Zadanie, w którym co najmniej jedno pole indeksu wsadu lub dokumentu 
skonfigurowano pod kątem użycia funkcji Double Entry (Podwójne 
wprowadzanie danych), służy do skanowania dokumentów w taki sam sposób 
jak inne zadania.

Po ukończeniu skanowania dokumentów, gdy wsad jest gotowy do 
indeksowania, operator wybiera pozycję Index > Index1 (Indeks > Indeks1). 
Powoduje to zmianę stanu wsadu z Available (Dostępny) na Index1 (Indeks1), 
co oznacza, że wsad jest gotowy do wprowadzania pierwszego zestawu 
wartości indeksu.

Gdy operator pierwszego indeksu wprowadzi wartości indeksu dla wszystkich 
dokumentów, wybrana zostaje pozycja Index > Index2 (Indeks > Indeks2). 
Powoduje to zmianę stanu wsadu ze stanu Index1 (Indeks1) na Index2 
(Indeks2), co oznacza, że wsad jest gotowy do wprowadzania drugiego 
zestawu wartości indeksu.

Operator drugiego indeksu nie będzie widział wartości wprowadzonych przez 
operatora pierwszego indeksu.

Jeśli wartość wprowadzona przez operatora drugiego indeksu jest zgodna 
z pierwszą wartością, nie jest wymagane żadne działanie i operacja 
indeksowania jest kontynuowana.

W przypadku niezgodności pierwszej i drugiej wartości zostaje wyświetlone 
okno dialogowe Entry Resolution (Rozwiązanie niezgodności) i operator 
wybiera właściwy wpis.
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UWAGI:

• Jeśli operator skanowania wprowadza również pierwszy zestaw wartości 
indeksu, niezbędne jest wybranie kolejno pozycji Index > Index1 (Indeks > 
Indeks1), a następnie — niezwłocznie po ukończeniu pierwszej operacji 
indeksowania — Index > Index2 (Indeks > Indeks2).

• Podczas porównywania wartości Index1 oraz Index2 jest rozróżniana 
wielkość liter. Na przykład tekst „WIELKIE LITERY” i tekst „Wielkie litery” nie 
będą traktowane jako identyczne. Zera na początku również są znaczące. 
Na przykład wartość 123 nie jest równa wartości 0123.

• Przed zapisaniem wartości w polach indeksu Double Entry (Podwójne 
wprowadzanie) zostaną usunięte znaki spacji na początku i końcu wartości. 

Na przykład wartość „ Dostawa ” zostanie zapisana jako „Dostawa”. 
Oznacza to, że jeżeli w polu Index1 wprowadzono wartość „ Shipment”, 
a w polu Index2 — wartość „Shipment ”, te wartości zostaną uznane za 
identyczne.

Entry Resolution 
(Rozwiązanie niezgodności)

Okno dialogowe Entry Resolution (Rozwiązanie niezgodności) jest 
wyświetlane, gdy wartość drugiego pola indeksu nie jest zgodna z wartością 
pierwszego pola.

Operator indeksu ma do wyboru następujące możliwości:

• Wybór wpisu dokonanego przez pierwszego operatora indeksu, czyli pozycji 
Entry1 (Wpis1).

• Wybór wpisu dokonanego przez siebie, czyli pozycji Entry2 (Wpis2).

• Wprowadzenie nowej wartości w polu New Entry (Nowy wpis), jeśli żadna 
z wartości nie jest prawidłowa.
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• Anulowanie i zamknięcie okna dialogowego Entry Resolution (Rozwiązanie 
niezgodności), aby zrezygnować z dokonywania wyboru. W przypadku 
wybrania opcji nierozwiązywania niezgodności wartości indeksu 
w przynajmniej jednym wymaganym polu indeksu i podjęcia próby 
przetworzenia wyjściowego wsadu, zostanie wyświetlony następujący 
komunikat: One or more index fields require Double Entry. You may not 
output the batch at this time. Do you wish to enter Index Mode? 
(Przynajmniej jedno pole indeksu wymaga podwójnego wprowadzenia 
wartości. W tej chwili nie można przeprowadzić przetwarzania 
wyjściowego wsadu. Czy chcesz przejść do trybu edycji indeksu?) 

Jeśli żadne z pól podwójnego wprowadzania danych nie jest wymagane, 
okno dialogowe Entry Resolution (Rozwiązanie niezgodności) zostanie 
wyświetlone podczas przetwarzania wyjściowego. Wszystkie pola indeksu 
wprowadzane podwójnie i zawierające niezgodności wpisów muszą być 
skorygowane przed przeprowadzeniem przetwarzania wyjściowego.

UWAGI:

• Jeśli pole z wprowadzaniem podwójnym nie jest polem wymaganym, jeden 
lub obydwa wpisy indeksu można pozostawić puste. Okno dialogowe Entry 
Resolution (Rozwiązanie niezgodności) nie będzie wyświetlane i nie będzie 
generowany błąd na wyjściu.

• Jeżeli podwójnie wprowadzone wartości nie są zgodne, operator musi 
dokonać wyboru w oknie dialogowym rozwiązania niezgodności przed 
przeprowadzeniem przetwarzania wyjściowego.

• Pole indeksu z włączoną funkcją podwójnego wprowadzania nie może być 
używane do przeszukiwania baz danych ani też nie może być polem 
weryfikowanym lub uzupełnianym za pomocą funkcji Database Lookup 
(Przeszukiwanie bazy danych).



36 A-61992_pl  marzec 2022

Menu Pomoc Menu Help (Pomoc) zawiera następujące opcje:

Help (Pomoc) — wyświetla pomoc online do oprogramowania Capture Pro. 
Skrót klawiaturowy: F1.

Capture Pro Getting Started Guide (Podręcznik referencyjny 
oprogramowania Capture Pro) — podręcznik referencyjny zawiera proste 
procedury obsługi oprogramowania Capture Pro i szybkiego rozpoczęcia 
pracy.

Send Error Report (Wyślij raport o błędach) — wyświetla okno dialogowe 
Send Error Report (Wysyłanie raportów o błędach) umożliwiające 
wprowadzenie komunikatu opisującego problem i przesłanie go do firmy 
Kodak Alaris.

License Manager (Menedżer licencji) — zapewnia dostęp do Menedżera 
licencji, który umożliwia łatwe uzyskanie licencji dla stacji roboczej 
z oprogramowaniem Capture Pro, ale bez dostępu do Internetu.

Register (Rejestracja) — umożliwia zarejestrowanie oprogramowania Capture 
Pro.

Capture Pro Online — wyświetla pomoc online do oprogramowania Capture 
Pro.

About Capture Pro (Informacje o oprogramowaniu Capture Pro) — wyświetla 
okno dialogowe About Capture Pro Software (Informacje o oprogramowaniu 
Capture Pro), które zawiera informacje o bieżącej wersji oprogramowania. 
W tym oknie znajdują się następujące informacje:

• Copyright (Prawa autorskie)
• File extension (Rozszerzenie plików)
• File path (Ścieżka do plików)
• Software serial number (Numer seryjny oprogramowania)
• Software version number (Numer wersji oprogramowania)

To okno dialogowe umożliwia również dostęp do opcji System Information 
(Informacje o systemie), z poziomu której można otworzyć okno Files 
Information (Informacje o plikach). Zawiera ono informacje dotyczące 
poszczególnych plików oprogramowania Capture Pro. Okno Files Information 
(Informacje o plikach) jest tylko do odczytu.
• File name (Nazwa pliku)
• File size (Rozmiar pliku)
• Creation date (Data utworzenia)
• Version number (Numer wersji)
• Opis

UWAGA: Aby zamknąć okno Files Information (Informacje o pliku), należy 
kliknąć przycisk „X” w prawym górnym rogu.



A-61992_pl  marzec 2022 37

Paski narzędzi

Pasek narzędzi 
Przechwytywanie

Pasek narzędzi Capture (Przechwytywanie) zawiera następujące polecenia:

Pasek narzędzi Wsad Pasek narzędzi Batch (Wsad) zawiera następujące polecenia:

Pasek narzędzi 
Dokument

Pasek narzędzi Document (Dokument) zawiera następujące polecenia:

Start — rozpoczyna skanowanie obrazów.

Stop Scan (Zatrzymaj skanowanie) — zatrzymuje skanowanie 
obrazów.

Page Setup name (Nazwa konfiguracji strony) — służy do wyboru z listy 
rozwijanej nazwy takiej konfiguracji strony, która najlepiej pasuje do 
bieżącego zadania skanowania.

Page Setup (Konfiguracja strony) — wyświetla okno dialogowe 
Page Setup (Konfiguracja strony) umożliwiające 
skonfigurowanie parametrów skanowania.
Sides to Capture (Strony do przechwycenia) — dostępne opcje: 
Two-sided (Dwustronnie), One-Sided Front (Jednostronnie — 
strona przednia) lub One-Sided Back (Jednostronnie — strona 
tylna).
UWAGA: Z opcji tej nie można korzystać w przypadku niektórych 

skanerów firm innych niż Kodak. 

New batch (Nowy wsad) — wyświetla okno dialogowe New 
Batch (Nowy wsad) umożliwiające utworzenie nowego wsadu.
Open batch (Otwórz wsad) — wyświetla okno dialogowe Batch 
Manager (Menadżer wsadu),które umożliwia otwarcie 
istniejącego wsadu.
Close batch (Zamknij wsad) — zamyka obecnie otwarty wsad.

Output batch (Przetwarzanie wyjściowe wsadu) — uruchamia 
przetwarzanie wyjściowe wszystkich obrazów z bieżącego 
wsadu.

New document (Nowy dokument) — umożliwia dodanie 
nowego dokumentu.
Insert Pages (Wstaw strony) — wstawia dodatkowe strony do 
zeskanowanego dokumentu. Ikona stanie się aktywna po 
zaznaczeniu pierwszego obrazu na stronie. Umieść w skanerze 
dodatkowe strony i kliknij tę ikonę.
Rescan Pages (Zeskanuj strony ponownie) — powtarza 
skanowanie wybranych części dokumentu. Zaznacz stronę lub 
strony do ponownego zeskanowania, umieść oryginały 
w skanerze i kliknij tę ikonę.
Split document (Podziel dokument) — dzieli dokument na dwa 
dokumenty na wybranej stronie. Aby podzielić dokument, kliknij 
ikonę Split document (Podziel dokument). W panelu Image 
Viewer (Przeglądarka obrazów) kliknij stronę, która zostanie 
wydzielona do nowego dokumentu. 
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Pasek narzędzi Widok Pasek narzędzi View (Widok) zawiera następujące polecenia:

Pasek narzędzi 
Nawigacja

Pasek narzędzi Navigation (Nawigacja) zawiera następujące polecenia:

Selector (Narzędzie wyboru) — wyświetla narzędzie wskaźnika, 
które pozwala wybierać obrazy.

Selection mode (Tryb wyboru) — wybierz Image (Obraz), 
Page (Strona) lub Page Side (Przód/tył strony). 

• W przypadku wyboru opcji Image (Obraz) można kliknąć 
obraz w panelu Image Viewer (Przeglądarka obrazów), co 
spowoduje zaznaczenie żądanego obrazu.

• W przypadku wyboru opcji Page (Strona) kliknięcie obrazu 
spowoduje zaznaczenie całej strony, jej przodu i tyłu, strony 
czarno-białej i kolorowej/w skali szarości.

• W przypadku skanowania wielu obrazów na jedną stronę 
(skanowanie dwustrumieniowe) wybranie opcji Page Side 
(Przód/tył strony) i kliknięcie obrazu z przodu spowoduje 
zaznaczenie wszystkich obrazów przednich. Kliknięcie obrazu 
tylnego spowoduje zaznaczenie wszystkich obrazów spodnich.

Magnify (Lupa) — umożliwia powiększenie części obrazu. 
Wybranie ikony Magnify (Lupa) spowoduje wyświetlenie 
narzędzia Magnify (Lupa). Umieszczenie narzędzia w dowolnym 
miejscu obrazu spowoduje powiększenie tego obszaru. (Należy 
kliknąć obraz i przytrzymać klawisz myszy).
Pan (Przesuń) — pozwala przesunąć obraz w oknie, gdy obraz 
jest większy od panelu.

Image Viewer Display (Tryb wyświetlania w przeglądarce 
obrazów) — umożliwia wybranie siatki 1, 2, 4 lub 8 obrazów albo 
wybranie opcji Customize (Dostosuj). Wybranie opcji 
Customize (Dostosuj) powoduje wyświetlenie okna 
dialogowego Custom Layout Setup (Konfiguracja układu 
niestandardowego), które umożliwia wprowadzenie liczby 
wierszy i kolumn do wyświetlenia w oknie Image Viewer 
(Przeglądarka obrazów).
Zoom In (Powiększenie) — powiększa wszystkie obrazy 
w oknie Image Viewer (Przeglądarka obrazów).

Zoom Out (Pomniejszenie) — pomniejsza wszystkie obrazy 
w oknie Image Viewer (Przeglądarka obrazów).

 

Quick Start (Szybki start) — otwiera ekran Quick start (Szybki 
start), który zawiera kafelki zadań służące do uruchamiania 
zadań skanowania.

First Document (Pierwszy dokument) — wyświetla pierwszy 
dokument wsadu w oknie Image Viewer (Przeglądarka obrazów).
Last Document (Ostatni dokument) — wyświetla ostatni 
dokument wsadu w oknie Image Viewer (Przeglądarka 
obrazów).
Previous Document (Poprzedni dokument) — wyświetla 
poprzedni dokument wsadu w oknie Image Viewer 
(Przeglądarka obrazów).
Next Document (Następny dokument) — wyświetla następny 
dokument wsadu w oknie Image Viewer (Przeglądarka obrazów).
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Pasek narzędzi Flaga Pasek narzędzi Flag (Flaga) zawiera następujące polecenia:

Pasek narzędzi Edycja Pasek narzędzi Edit (Edycja) zawiera następujące polecenia:

Narzędzie Flag (Flaga) — umożliwia dodanie flagi do strony lub 
obrazu. Można na przykład trwale oznaczyć obrazy wymagające 
ponownego skanowania. Można na przykład trwale oznaczyć obrazy 
wymagające ponownego skanowania.
Flag All Selected (Oznacz wszystkie zaznaczone) — dodaje flagę do 
wszystkich zaznaczonych obrazów wsadu.

Flag Filtered (Oznacz filtrowane) — umożliwia dodanie flagi do 
obrazów obecnie wyświetlanych w oknie Image Viewer (Przeglądarka 
obrazów) lub Thumbnail Viewer (Przeglądarka miniatur). 
Unflag All (Usuń wszystkie flagi) — usuwa flagi ze wszystkich 
wcześniej oznaczonych obrazów w bieżącym wsadzie.

Edit Index Fields (Edytuj pola indeksu) — zapewnia dostęp do pól 
indeksu na poziomie wsadu i dokumentu.

Rotate 90 (Obróć o 90) — obraca zaznaczone obrazy o 90 stopni 
w prawo.

Rotate 180 (Obróć o 180) — obraca zaznaczone obrazy o 180 stopni 
w prawo.

Rotate 270 (Obróć o 270) — obraca zaznaczone obrazy o 270 stopni 
w prawo.

Intelligent QC — uruchamia narzędzie Intelligent QC. Wszystkie 
zaznaczone obrazy będą dostępne do przeglądania i przetwarzania. 
Jeśli nie wybrano żadnego obrazu, będą dostępne wszystkie obrazy 
oznaczone flagą. Narzędzie Intelligent QC można też uruchomić, 
klikając prawym przyciskiem myszy obraz w panelu Image Viewer 
(Przeglądarka obrazów) lub Batch Explorer (Eksplorator wsadów) 
i wybierając pozycję Intelligent QC z wyświetlonej listy.
Draw Region (Rysuj obszar) — umożliwia zaznaczenie 
prostokątnego fragmentu obrazu i usunięcie jego zawartości za 
pomocą polecenia Blank (Wyczyść) lub przycięcie obrazu 
do wielkości prostokąta za pomocą polecenia Crop (Przytnij).
Crop (Przytnij) — umożliwia usunięcie obszaru znajdującego się 
poza prostokątem utworzonym za pomocą opcji Draw Region (Rysuj 
obszar). 
Blank (Wyczyść) — umożliwia wyczyszczenie obszaru znajdującego 
się wewnątrz prostokąta utworzonego za pomocą opcji Draw Region 
(Rysuj obszar). Po wybraniu tej ikony zostanie wyświetlone okno 
z potwierdzeniem. 
Print (Drukuj) — wyświetla okno dialogowe Print Setting (Ustawienia 
drukowania), które umożliwia wydrukowanie całego dokumentu lub 
określonych obrazów w dokumencie.
Save As PDF (Zapisz jako PDF) — wyświetla okno dialogowe Save 
as PDF (Zapisz jako PDF), które umożliwia zapisanie dokumentu lub 
poszczególnych obrazów w formacie PDF z możliwością 
wyszukiwania lub bez niej.
Delete Selected (Usuń zaznaczone) — usuwa zaznaczone obrazy 
z dokumentu. Na przykład można usunąć puste obrazy z dokumentu 
dwustronnego. Po usunięciu wybranych obrazów pozostałe zostaną 
ponownie ponumerowane. Po wybraniu tej ikony zostanie 
wyświetlone okno z potwierdzeniem.
Undo (Cofnij) — przywraca stan sprzed ostatniej czynności 
przycięcia, wyczyszczenia lub obrotu obrazu albo zestawu obrazów. 
Opcja Undo (Cofnij) nie cofa poleceń usunięcia.
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Pasek narzędzi Indeks Pasek narzędzi Index (Indeks) zawiera następujące polecenia:

Pasek narzędzi 
Dostosowanie skanera

Pasek narzędzi Scanner Adjustments (Dostosowanie skanera) umożliwia 
zmianę wymienionych poniżej opcji skanowania bezpośrednio z poziomu okna 
głównego oprogramowania Capture Pro.

UWAGI:

• Pasek narzędzi Scanner Adjustments (Dostosowanie skanera) jest 
dostępny tylko w przypadku skanerów marki Kodak i można go używać 
tylko z tymi skanerami.

Previous document (Poprzedni dokument) — przechodzi do 
poprzedniego numeru dokumentu zawierającego obrazy.

Next document (Następny dokument) — przechodzi do 
następnego dokumentu zawierającego obrazy.

Next Invalid (Następny nieprawidłowy) — przechodzi do 
następnego dokumentu zawierającego nieprawidłowy indeks.

Zoom Zones (Strefy powiększenia) — powiększa obszar 
wyświetlania danych indeksu przechwyconych dla bieżącego pola, 
umożliwiając wyraźniejsze zobaczenie trudnych do odczytania 
znaków specjalnych.
Drag-and-Drop OCR (OCR typu przeciągnij i upuść) — umożliwia 
indeksowanie typu „przeciągnij i upuść” przy użyciu oprogramowania 
do optycznego rozpoznawania tekstu (OCR), bez konieczności 
wprowadzania wartości indeksów. Po wybraniu tego narzędzia 
narysuj prostokąt wokół danych indeksu do przechwycenia.
Ta ikona umożliwia ustawienie wybranego pola indeksu przez 
kliknięcie wyrazu lub wartości. Aby dołączyć więcej wyrazów lub 
wartości, naciśnij klawisz Ctrl, a następnie klikaj dodatkowe wyrazy 
lub wartości.
OCR Language (Język OCR) — umożliwia wybór języka 
używanego przez funkcję OCR z listy rozwijanej. 

Save & Exit Indexing (Zapisz i zamknij okno indeksowania) — 
zapisuje wszystkie zmiany wprowadzone w bieżącym wsadzie 
i zamyka okno indeksowania. 
Cancel & Exit Indexing (Anuluj i zamknij okno indeksowania) — 
powoduje zamknięcie okna indeksowania bez zapisania zmian.

Threshold (Próg) — określa poziomy jasności i ciemności 
tła obrazu. Prawidłowe są wartości od 0 do 255. Próg dla 
obrazu przedniego i tylnego ustawia się oddzielnie.

Contrast (Kontrast) — poprawia widoczność krawędzi 
w dokumencie. Im wyższy poziom kontrastu, tym 
wyraźniejsze są krawędzie. Dopuszczalny zakres wartości 
wynosi od 0 do 100 lub od -50 do 50 w zależności od 
modelu skanera. Kontrast strony przedniej i tylnej ustawia 
się oddzielnie.
iThresholding — wybór tej opcji spowoduje automatyczne 
określenie optymalnego ustawienia progu dla każdej 
zeskanowanej strony i poprawę ogólnej wydajności oraz 
jakości obrazu. Po wybraniu tej opcji ustawienia progu 
(Treshold) dla obrazu przedniego i tylnego są wyszarzone 
i nie można ich modyfikować.

Front Back
(Przód) (Tył)

Front Back
(Tył)(Przód)
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• Wszelkie zmiany dokonane w ustawieniach są tymczasowe i nie powodują 
zmiany obecnie wybranej konfiguracji strony używanej do skanowania.

• Zmiana konkretnych ustawień dostępnych na tym pasku narzędzi jest 
wskazana ich wyróżnieniem na żółto.

• W przypadku zmiany konfiguracji strony używanej do skanowania lub 
ponownego wybrania tej samej konfiguracji strony ustawienia paska 
narzędzi Scanner Adjustments (Dostosowanie skanera) zostaną 
zresetowane do wartości zdefiniowanych w konfiguracji strony.

Eksplorator wsadów Batch Explorer (Eksplorator wsadów) wyświetla wszystkie foldery 
dokumentów oraz pliki stron i obrazów należące do wsadu obecnie otwartego 
w oknie Image Viewer (Przeglądarka obrazów). Eksplorator jest wyświetlany 
automatycznie z lewej strony okna głównego, gdy włączono układ 
zaawansowany (Enhanced).

• Kliknij wybrany plik obrazu w oknie Batch Explorer (Eksplorator wsadów). 
Wybrany obraz zostanie wyświetlony w oknie Image Viewer (Przeglądarka 
obrazów).

• Przeciągnij plik obrazu, plik stron lub folder dokumentu w inne miejsce 
w oknie Batch Explorer (Eksplorator wsadów).

• Kliknij prawym przyciskiem myszy plik obrazu, plik stron lub folder 
dokumentu, aby wyświetlić menu kontekstowe zawierające więcej opcji.

• Naciśnij klawisz Ctrl oraz klawisz:

+ — aby rozwinąć wszystkie węzły

- — aby zwinąć wszystkie węzły

L — aby utworzyć nowy dokument, rozpoczynając od wybranej strony

X — aby wyciąć wybraną stronę lub wybrany obraz

V — aby wkleić ostatnio wyciętą stronę lub obraz przed zaznaczoną stroną 
albo obrazem

- Jeśli ostatnio wycięta była strona i wybrano obraz, naciśnięcie 
klawiszy Ctrl + V spowoduje wstawienie strony przed stroną 
zawierającą wybrany obraz.

- Jeśli ostatnio wycięty był obraz i wybrano stronę, naciśnięcie klawiszy 
Ctrl + V spowoduje wstawienie obrazu przed pierwszym obrazem 
wybranych stron.
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Przeglądarka 
obrazów

Image Viewer (Przeglądarka obrazów) to obszar, w którym są wyświetlane 
wszystkie obrazy. Przeglądarkę obrazów można tak skonfigurować, aby 
równocześnie wyświetlać 1, 2, 4, 8 lub więcej obrazów. Istnieje też możliwość 
dostosowania układu przeglądarki.

Pasek tytułu zawiera nazwę wsadu i numer dokumentu odnoszące się do 
obrazów wyświetlanych w panelu Image Viewer (Przeglądarka obrazów). 

Aby przenieść obraz:
1. Wybierz obraz.
2. Przeciągnij obraz do żądanej lokalizacji.

Aby usunąć obraz:
1. Wybierz obraz. 
2. Wybierz kolejno opcje Edit > Delete (Edycja > Usuń). Obraz zostanie 

usunięty z dokumentu.

Aby zmienić liczbę wyświetlanych obrazów:
1. Wybierz kolejno pozycje View > Image Viewer Display (Widok > Tryb 

wyświetlania w przeglądarce obrazów).
2. Wybierz opcję 1, 2, 4, 8 lub Customize (Dostosuj). W oknie Image Viewer 

(Przeglądarka obrazów) zostanie wyświetlony wybrany układ.

UWAGA: Wybranie opcji Customize (Dostosuj) spowoduje wyświetlenie 
okna dialogowego Custom Layout Setup (Konfiguracja układu 
niestandardowego), które umożliwia wprowadzenie liczby 
kolumn i wierszy do wyświetlenia.

Menu kontekstowe 
obrazu

Kliknięcie prawym przyciskiem myszy obrazu w oknie Image Viewer 
(Przeglądarka obrazów) powoduje wyświetlenie menu zawierającego 
następujące opcje:

Mark As Blank (Oznacz jako pusty) — oznacza obrazy jako puste po 
wybraniu tej opcji w oknie Image Viewer (Przeglądarka obrazów) lub kliknięciu 
obrazu prawym przyciskiem myszy. Polecenie jest dostępne tylko po 
włączeniu opcji „Keep blank images” (Zachowaj puste obrazy) w obszarze 
„Auto Delete” (Usuwanie automatyczne) wybranej konfiguracji strony. Wybrany 
obraz jest wyróżniony w Przeglądarce obrazów ciemnoniebieską ramką.

Selection Mode (Tryb wyboru) — można wybrać opcję Image (Obraz), 
Page (Strona) lub Page Side (Przód/tył strony). 

• W przypadku wyboru opcji Image (Obraz) można kliknąć obraz w panelu 
Image Viewer (Przeglądarka obrazów), co spowoduje zaznaczenie 
żądanego obrazu.

• W przypadku wyboru opcji Page (Strona) kliknięcie obrazu spowoduje 
zaznaczenie całej strony, jej przodu i tyłu, strony czarno-białej i kolorowej/
w skali szarości.

• W przypadku skanowania wielu obrazów na jedną stronę (skanowanie 
dwustrumieniowe) wybranie opcji Page Side (Przód/tył strony) i kliknięcie 
obrazu z przodu spowoduje zaznaczenie wszystkich obrazów przednich. 
Kliknięcie obrazu tylnego spowoduje zaznaczenie wszystkich obrazów 
spodnich.

Deselect All (Anuluj zaznaczenie wszystkich) — anuluje zaznaczenie wyróż-
nionych obrazów w oknie Przeglądarce obrazów.
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Delete (Usuń) — usuwa wszystkie wyróżnione obrazy po potwierdzeniu przez 
użytkownika.

Copy (Kopiuj) — kopiuje wybrany obraz w celu wklejenia w innej lokalizacji.

Copy Image Area (Kopiuj obszar obrazu) — ta opcja służy do skopiowania 
obszaru utworzonego przy użyciu narzędzia Draw Region (Rysuj obszar) do 
innej lokalizacji.

Copy Image to Job Setup (Kopiuj obraz do konfiguracji zadania) — wyświetla 
okno dialogowe Copy Image to Job Setup (Kopiuj obraz do konfiguracji 
zadania), które umożliwia importowanie obrazów do okna Bar Code (Kod 
kreskowy) lub okna OCR w celu utworzenia strefy kodu kreskowego lub OCR.

Rotate (Obróć) — obraca zaznaczony obraz o 90, 180 lub 270 stopni 
w prawo.

Intelligent QC — uruchamia narzędzie Intelligent QC. Wszystkie zaznaczone 
obrazy będą dostępne do przeglądania i przetwarzania. Jeśli nie wybrano 
żadnego obrazu, dostępne będą wszystkie obrazy oznaczone flagą.

Split Document (Podziel dokument) — dzieli ręcznie zaznaczony dokument 
na dwa odrębne dokumenty.

Merge into Previous (Połącz z poprzednim) — dołącza obecnie skanowany 
dokument do poprzedniego dokumentu, tworząc jeden dokument.

Zoom — służy do powiększania i pomniejszania rozmiaru wyświetlanego 
obrazu. 

• Fits Images to window (Dopasuj obrazy do okna): dopasowuje każdy 
obraz do jego okienka w panelu Image Viewer (Przeglądarki obrazów) 
niezależnie od oryginalnego rozmiaru.

• Actual (Rozmiar rzeczywisty): powiększa obraz do rzeczywistych 
rozmiarów fizycznych.

• Zoom In (Powiększenie): powiększa obraz o ustaloną wartość procentową 
zgodnie z ustawieniem parametru Zoom Step (Skok powiększenia).

• Zoom Out (Pomniejszenie): pomniejsza obraz o ustaloną wartość 
procentową zgodnie z ustawieniem parametru Skok powiększenia.

• Zoom Step (Skok powiększenia): służy do wyświetlania okna dialogowego 
Zoom Step (Skok powiększenia), które umożliwia wybór wartości 
procentowej skalowania w zakresie od 15 do 40% w przyrostach 5%.

Pan All Images to (Przesuń wszystkie obrazy) — pozwala przesunąć 
wszystkie obrazy odpowiednio do opcji: Top (Do góry), Bottom (W dół), 
Left (W lewo), Right (W prawo) lub Same (W tę samą pozycję).

Pan Step Setup (Konfiguracja skoku przesunięcia) — wyświetla okno 
dialogowe Pan Step Setup (Konfiguracja skoku przesunięcia), które umożliwia 
zmianę ustawień pikseli dla narzędzia przesunięcia obrazu.

Hide Front (Ukryj przednie) — ukrywa wszystkie przednie obrazy należące do 
danego wsadu. 

Hide Back (Ukryj tylne) — ukrywa wszystkie tylne obrazy wsadu.

Hide Black and White (Ukryj czarno-białe) — ukrywa wszystkie obrazy 
czarno-białe należące do danego wsadu.

Hide Grayscale (Ukryj skalę szarości) — ukrywa wszystkie obrazy w skali 
szarości należące do danego wsadu.
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Hide Color (Ukryj kolorowe) — ukrywa wszystkie obrazy kolorowe należące 
do danego wsadu.

Wybranie narzędzia Flag (Flaga), Magnify (Lupa) lub Hide Front  (Rysuj 
obszar) przed kliknięciem obrazu prawym przyciskiem myszy spowoduje 
wyświetlenie dodatkowych opcji menu.

• Jeśli narzędzie Flaga jest aktywne, zostaną wyświetlone opcje flagi. 

- Flag All Selected (Oznacz wszystkie zaznaczone) — dodaje zielone 
znaczniki wyboru do wszystkich wybranych obrazów wsadu. Aby wybrać 
więcej niż jeden obraz, przytrzymaj wciśnięty klawisz Control (Ctrl) i klikaj 
obrazy w oknie Image Viewer (Przeglądarka obrazów).

- Flag All  (Oznacz wszystkie) — dodaje zielone znaczniki wyboru do 
wszystkich obrazów wsadu.

- Unflag All  (Usuń wszystkie flagi) — usuwa zielone znaczniki wyboru ze 
wszystkich obrazów wsadu.

- Flag Filtered (Oznacz filtrowane) — powoduje dodanie zielonych 
znaczników wyboru do wszystkich odfiltrowanych (wyświetlonych) 
obrazów.

• Jeśli narzędzie Magnify (Lupa) jest aktywne, zostanie wyświetlona opcja 
Magnification Ratio (Współczynnik powiększenia). Kliknięcie tej opcji 
powoduje wyświetlenie okna Magnification Ratio Setup (Konfiguracja 
współczynnika powiększenia), w którym można określić rozmiar obrazu 
wyświetlanego podczas używania narzędzia Lupa.

• Jeśli narzędzie Draw Region (Rysuj obszar) jest aktywne, zostaną 
wyświetlone opcje związane z tym narzędziem. 

- Apply Region to Document (Zastosuj obszar do dokumentu) — 
umieszcza zaznaczony obszar na wszystkich obrazach w dokumencie.

- Apply Region to Selected (Zastosuj obszar do wybranych) — 
umieszcza zaznaczony obszar tylko na wybranych obrazach.

- Crop (Przytnij) — umożliwia usunięcie obszaru znajdującego się poza 
prostokątem utworzonym za pomocą opcji Draw Region (Rysuj obszar). 
Po wybraniu tej opcji zostanie wyświetlone okno z potwierdzeniem.

- Blank (Wyczyść) — umożliwia wyczyszczenie obszaru znajdującego się 
wewnątrz prostokąta utworzonego za pomocą opcji Draw Region (Rysuj 
obszar). Po wybraniu tej opcji zostanie wyświetlone okno 
z potwierdzeniem.
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Przeglądarka 
miniatur

W oknie Thumbnail Viewer (Przeglądarka miniatur) są wyświetlane 
pomniejszone wersje wszystkich obrazów obecnie otwartego wsadu.

Aby wybrać obraz w Przeglądarce obrazów:

• Kliknij miniaturę w oknie Thumbnail Viewer (Przeglądarka miniatur).

Aby powiększyć miniaturę:
• Kliknij obraz lewym przyciskiem myszy i przytrzymaj. Przytrzymując 

naciśnięty przycisk, możesz przesuwać powiększony obszar.

Menu kontekstowe 
Przeglądarki miniatur

Kliknięcie prawym przyciskiem myszy obrazu w oknie Przeglądarki miniatur 
powoduje wyświetlenie menu zawierającego następujące opcje:
Hide Front (Ukryj przednie) lub Hide Back (Ukryj tylne) — ukrywa wszystkie 
miniatury przednie lub tylne. 

Hide Black and White (Ukryj czarno-białe), Hide Grayscale (Ukryj w skali 
szarości) lub Hide Color (Ukryj kolorowe) — ukrywa wszystkie miniatury 
czarno-białe, w skali szarości lub kolorowe.

Thumbnail Image Size (Rozmiar miniatury) — zostanie wyświetlone okno 
dialogowe Thumbnail Image Size Setup (Konfiguracja rozmiaru miniatur) 
pozwalające dostosować rozmiar obrazów.

Narzędzie Intelligent 
QC

Wybranie narzędzia Intelligent QC na pasku narzędzi Edit (Edycja) powoduje 
uruchomienie narzędzia Intelligent QC. Wszystkie zaznaczone obrazy będą 
dostępne do przeglądania i przetwarzania. Jeśli nie wybrano żadnego obrazu, 
będą dostępne wszystkie obrazy oznaczone flagą. Narzędzie Intelligent QC 
można również uruchomić, klikając prawym przyciskiem myszy obraz 
w panelu Image Viewer (Przeglądarka obrazów) lub Batch Explorer 
(Eksplorator wsadów) i wybierając pozycję Intelligent QC z wyświetlonej listy.

UWAGA: Narzędzie Intelligent QC nie jest dostępne podczas skanowania, 
ponownego skanowania lub gdy funkcja Auto Import (Importowanie 
automatyczne) monitoruje aktywny folder w oczekiwaniu na pliki 
obrazów.

Po wybraniu narzędzia Intelligent QC w lewym panelu obrazu zostanie 
wyświetlony pierwszy obraz. Lewy panel będzie pokazywać obraz bez 
żadnego dodatkowego przetwarzania. Prawy panel obrazu będzie wyświetlał 
obraz po zastosowaniu wybranych opcji przetwarzania obrazu.
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Obraz można edytować, klikając wybrane ikony narzędzi przetwarzania 
obrazu znajdujące się między panelami obrazu. Aby cofnąć działanie funkcji 
przetwarzania obrazu, kliknij ponownie wybrane narzędzie, co spowoduje 
anulowanie jego zaznaczenia.

Apply settings to next image (Zastosuj ustawienia do następnego obrazu) — 
w przypadku zaznaczenia tej opcji wybrane narzędzia przetwarzania obrazu 
oraz ich ustawienia zostaną zastosowane do kolejnego obrazu. W przypadku 
wybrania narzędzia Binarize (Binaryzacja), gdy kolejnym obrazem jest obraz 
czarno-biały, binaryzacja nie zostanie zastosowana. Jeżeli jednak włączono 
również narzędzie Hole Fill (Wypełnianie otworów), efekt ten zostanie 
zastosowany do obrazu czarno-białego.

Apply To All (Zastosuj do wszystkich) — spowoduje zastosowanie wybranych 
narzędzi przetwarzania obrazu do wszystkich obrazów zaznaczonych za 
pomocą narzędzia Intelligent QC.

Next (Następny) — przycisk wyświetlany, jeśli są dostępne dalsze obrazy do 
przeglądu. Kliknięcie przycisku Next (Następny) powoduje zapisanie 
bieżącego obrazu w takim stanie, w jakim jest on wyświetlany w prawym 
panelu obrazu przetworzonego. W przypadku zaznaczenia pola wyboru opcji 
Apply to Next (Zastosuj do następnego) wybrane narzędzia przetwarzania 
obrazu zostaną zastosowane do następnego obrazu. Obraz przed 
przetworzeniem zostanie wyświetlony w lewym panelu obrazu Original 
(Oryginalny), a obraz przetworzony będzie widoczny w prawym panelu obrazu 
Processed (Przetworzony). 

Back (Poprzedni) — pokazuje poprzednio wyświetlany obraz. Wszystkie 
wybrane narzędzia zostaną wyłączone, a zaznaczenie pola wyboru opcji 
Apply to Next (Zastosuj do następnego) zostanie anulowane. Obraz zostanie 
wyświetlony w takim stanie, w jakim był, gdy naciśnięto przycisk Next 
(Następny).

View B&W (View Grayscale / Color) (Wyświetl obraz czarno-biały / w skali 
szarości / kolorowy) — gdy są dostępne obrazy w skali szarości / kolorowe 
i powiązane obrazy czarno-białe (skanowanie dwustrumieniowe), w panelu 
obrazu Original (Oryginalny) zostanie wyświetlony obraz czarno-biały. Aby 
wyświetlić obraz w skali szarości / kolorowy, kliknij przycisk View Grayscale/
Color (Wyświetl obraz w skali szarości / kolorowy).
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Okno Indeks Dla wygody użytkownika w oknie Index (Indeks) po prawej stronie panelu 
Image Viewer (Przeglądarka obrazów) są wyświetlane dane indeksu dla 
każdego wsadu i dokumentu, dla którego zdefiniowano indeksy. Okno to jest 
dostępne w postaci karty wysuwanej z prawej strony ekranu. Dane indeksu 
można wyświetlać przez krótki czas (umieszczając kursor na ograniczniku 
karty) lub przypiąć do wyświetlanego obrazu, aby ciągle obserwować pola 
indeksu dla wszystkich obrazów skanowanych w programie Capture Pro. 
Tej funkcji można używać do wyświetlania pól indeksu konkretnego 
dokumentu lub całego wsadu. Aby wprowadzić niezbędne poprawki do 
zawartości poszczególnych pól indeksu, należy przejść do trybu 
indeksowania, wybierając pozycję Edit Index Fields (Edytuj pola indeksu) 
z menu Index (Indeks). 

Aby otworzyć okno Index (Indeks):

• Kliknij kartę okna Index (Indeks) z prawej strony Przeglądarki obrazów. Aby 
pozostawić okno otwarte, kliknij ikonę pinezki w prawym górnym rogu okna.

Aby zamknąć okno Index (Indeks):

• Kliknij dwukrotnie ikonę pinezki lub kliknij w dowolnym miejscu poza oknem 
Index (Indeks). Gdy okno jest otwarte i przypięte, kliknij jednokrotnie ikonę 
pinezki, aby je zamknąć.
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Okno Informacje Okno Information (Informacje) znajdujące się z prawej strony okna Image 
Viewer (Przeglądarka obrazów) zawiera informacje statystyczne dotyczące 
obecnie otwartego wsadu. Otwarte okno informacji można przypiąć, aby stale 
obserwować dane statystyczne wsadu podczas skanowania obrazów za 
pomocą oprogramowania Capture Pro.

Informacje wyświetlane w tym oknie mogą obejmować cały wsad albo 
poszczególne dokumenty, strony lub obrazy. Informacje dotyczące obrazu 
obejmują numer kolejny obrazu, identyfikator strony, lokalizację na dysku, 
informacje o stopniu skompresowania, rozdzielczości, rozmiarze obrazu 
i ciągu drukowania.

Aby otworzyć okno Information (Informacje):
1. Zaznacz obraz, stronę lub dokument w oknie Batch Explorer (Eksplorator 

wsadów) lub zaznacz obraz w oknie Image Viewer (Przeglądarka 
obrazów).

2. Kliknij okno Information (Informacje) po prawej strony Przeglądarki 
obrazów. Aby pozostawić okno otwarte, kliknij ikonę pinezki w prawym 
górnym rogu okna.

Aby zamknąć okno Information (Informacje):
• Kliknij dwukrotnie ikonę pinezki lub kliknij w dowolnym miejscu poza oknem 

Information (Informacje). Gdy okno jest otwarte i przypięte, kliknij 
jednokrotnie ikonę pinezki, aby je zamknąć.
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Okno stanu 
przetwarzania wsadu

Okno Capture Pro Batch Process Status (Stanu przetwarzania wsadu 
oprogramowania Kodak Capture Pro) zawiera informacje dotyczące wsadów 
przygotowywanych do przetwarzania wyjściowego za pomocą 
oprogramowania Capture Pro.

Kliknij przycisk Control (Sterowanie), aby wyświetlić menu Control 
(Sterowanie):

• Show Log (Wyświetl dziennik) — otwiera okno Notatnika i wyświetla 
dziennik przetwarzania wyjściowego.

• Clear log (Wyczyść dziennik) — usuwa wszystkie wpisy z dziennika 
wyjściowego. Zostanie wyświetlone okno dialogowe potwierdzenia.

• About (Informacje o programie) — wyświetla okno dialogowe About 
Capture Pro Software (Informacje o oprogramowaniu Capture Pro) 
z przyciskiem służącym do wyświetlenia wszystkich plików programu 
Capture Pro.

• Exit (Wyjście) — otwiera okno dialogowe Shutdown Options (Opcje 
zamykania) zawierające polecenia zamknięcia oprogramowania Capture 
Pro. Przetwarzanie wyjściowe odbywa się w tle i niezależnie od 
oprogramowania Capture Pro. Próba zamknięcia oprogramowania Capture 
Pro spowoduje wyświetlenie monitu z zapytaniem, czy kontynuować lub 
zatrzymać proces przetwarzania wyjściowego.

Okno stanu przetwarzania wsadu oprogramowania Capture Pro udostępnia 
następujące informacje o każdym wsadzie, którego przetwarzanie wyjściowe 
się zakończyło lub trwa: Job Name (Nazwa zadania), Batch Name (Nazwa 
zadania), Submit Time (Czas przesłania), Status (Stan), User Name (Nazwa 
użytkownika), Progress (Postęp) i Description (Opis).

• Kliknij prawym przyciskiem myszy pozycję w kolumnie Batch Name 
(Nazwa wsadu) i wybierz polecenie Clear All Errors (Usuń wszystkie 
błędy) lub Clear Selected Errors (Usuń wybrane błędy).

Aby wyświetlić okno stanu przetwarzania wsadu:

• Wybierz kolejno Batch > View Batch Output Status (Wsad > Wyświetl stan 
przetwarzania wyjściowego wsadów).

Pasek stanu Pasek stanu oprogramowania Capture Pro zawiera informacje dotyczące 
bieżącego wsadu, bieżącego dokumentu, wolnego miejsca na dysku oraz 
włączenia/wyłączenia filtrów wyświetlania obrazu. Pasek stanu znajduje się 
w dolnej części ekranu i można go włączać i wyłączać, zaznaczając pozycję 
Status bar (Pasek stanu) w menu View (Widok) lub anulując zaznaczenie. 
Można też użyć skrótu klawiaturowego Ctrl + S.
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Pasek stanu zawiera informacje o wolnym miejscu na dysku w megabajtach, 
liczbie dokumentów, stron i obrazów znajdujących się w obecnie otwartym 
wsadzie, liczbie obrazów w dokumencie obecnie wyświetlanym w oknie 
Przeglądarki obrazów i stanie filtrów obrazu.

Jeśli filtr obrazu jest włączony, typy obrazów takie jak „strony tylne obrazów” 
lub „obrazy w skali szarości” nie są wyświetlane, stosownie do opcji 
wybranych w menu View > Image Viewer Filter (Widok > Filtr przeglądarki 
obrazów).

Modyfikacja 
interfejsu okna 
głównego

Podczas skanowania stron obrazy są widoczne we wszystkich otwartych 
przeglądarkach, takich jak: Image Viewer (Przeglądarka obrazów), Thumbnail 
Viewer (Przeglądarka miniatur) oraz Batch Explorer (Eksplorator wsadów). 
Oprogramowanie Capture Pro ma dwa domyślne układy ekranu: Classic 
(Klasyczny) i Enhanced (Zaawansowany). 

Oprogramowanie Capture Pro umożliwia dostosowanie układu okna głównego 
przez przenoszenie pasków narzędzi, przeglądarek itp. w celu dopasowania 
do preferencji użytkowników i ukrycia wszelkich niepotrzebnych elementów 
ekranu.

Te opcje mają zastosowanie do okna Image Viewer (Przeglądarka obrazów), 
Batch Explorer (Eksplorator wsadów), Thumbnail Viewer (Przeglądarka 
miniatur), okna Information (Informacje) oraz okna Index (Indeks). Ikony 
znajdują się w prawym górnym rogu okien:

Zamyka okno. Aby otworzyć okno ponownie, wybierz żądane 
okno do wyświetlenia z menu View (Widok).

Przypina otwarte okno do ekranu. Aby włączyć funkcję 
automatycznego ukrywania okna, kliknij ikonę pinezki.

Ukrywa automatycznie okno, pozostawiając na ekranie jedynie 
pasek tytułu. Aby wyświetlić okno, przesuń kursor na pasek 
tytułu.
Ikony zakotwiczenia (widoczne jako cztery kropki w pionie) 
znajdują się w lewym górnym rogu okna. Po wybraniu ikony 
zakotwiczenia i przytrzymaniu przycisku myszy następuje 
zwolnienie kotwicy obrazu i zostają wyświetlone niebieskie 
strzałki lokalizacji. Przytrzymując wciśnięty przycisk myszy, 
można przesunąć okno w nowe miejsce. Gdy okno znajdzie się 
w odpowiednim miejscu, wystarczy zwolnić przycisk myszy.
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Użytkownik może dostosować rozmiar obrazów wyświetlanych 
w przeglądarkach. W Przeglądarce obrazów można wyświetlać obrazy 
o stałym rozmiarze lub dostosowane za pomocą opcji Best Fit (Najlepsze 
dopasowanie), której działanie polega na takim powiększeniu obrazu, aby jak 
najlepiej pasował do ekranu. 

Paski narzędzi i okna obrazów można przesuwać oraz ukrywać stosownie 
do potrzeb. Oprogramowanie Capture Pro zapamiętuje ustawienia każdego 
zadania przy jego zamykaniu. Oznacza to, że poszczególne zadania mogą 
być wyświetlane w odmienny sposób. W dowolnym momencie można wybrać 
kolejno pozycje View > Layout > Classic (Widok > Układ > Klasyczny) lub 
Enhanced (Zaawansowany) i przywrócić domyślny układ ekranu.

W przypadku korzystania z klasycznego układu ekranu, aby dodać okno 
z układu zaawansowanego, należy wyświetlić menu View (Widok) i wybrać 
okno, np. Batch Explorer (Eksplorator wsadów), Index (Indeks) itp. Dodatkowe 
okno zostanie wyświetlone w układzie klasycznym.

• Układ klasyczny — jest widoczne wyłącznie okno Image Viewer 
(Przeglądarka obrazów). W oknie przeglądarki obrazów może się 
znajdować 1, 2, 4, 8 obrazów albo można dostosować układ tak, aby 
zawierał maksymalnie 6 kolumn na 6 wierszy.
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• Układ zaawansowany — zawiera okna Image Viewer (Przeglądarka 
obrazów), Thumbnail Viewer (Przeglądarka miniatur) i Batch Explorer 
(Eksplorator wsadów). Rozmiar każdego okna można dostosować.
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3   Rozwiązywanie problemów

Wsparcie techniczne Informacje związane ze wsparciem technicznym oprogramowania Capture Pro 
można znaleźć w witrynie internetowej firmy Kodak Alaris: 
www.alarisworld.com/go/CaptureProSupport. Strony internetowe wsparcia 
technicznego zapewniają dostęp do informacji dotyczących konkretnych 
produktów i akcesoriów, pobierania uaktualnień i sterowników oraz często 
zadawanych pytań (FAQ), a także szczegóły opcji wsparcia technicznego 
dostępnego dla użytkowników oprogramowania Capture Pro w danym kraju/
regionie.

 

www.kodakalaris.com/go/CaptureProSupport
www.kodakalaris.com/go/CaptureProSupport
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Dodatek A   Skróty klawiaturowe

Korzystając z oprogramowania Capture Pro Software, można używać 
następujących skrótów klawiaturowych:

• Skrót F1 — Pomoc jest dostępny w każdym miejscu programu Capture Pro 
Software.

• Batch Explorer / Image Viewer (Eksplorator wsadów / Przeglądarka 
obrazów): są dostępne następujące skróty:

Ogólne
J Konfiguracja zadania

F2 Pokaż listę konfiguracji strony
F5 Pokaż konfigurację strony
F3 Otwórz wsad
F7 Rozpocznij skanowanie
F6 Zatrzymaj skanowanie

Enter Zeskanuj nowy dokument
Ctrl-Enter Zeskanuj nowy dokument

O Przetwarzanie wyjściowe wsadu
Ctrl+Shift-W Zamknij wsad

Ctrl+S Pokaż/ukryj pasek stanu
Ctrl+P Drukuj

Wyświetlanie i edytowanie
A Wyświetl obraz w rzeczywistym rozmiarze
F Dopasuj obraz do okna

1,2,4 lub 8 Ustaw liczbę obrazów wyświetlanych 
w Przeglądarce obrazów

Ctrl-F9 Pokaż/ukryj obrazy kolorowe 
Ctrl-F10 Pokaż/ukryj obrazy w skali szarości 
Ctrl-F11 Pokaż/ukryj obrazy czarno-białe 
Ctrl-A Zaznacz wszystkie obrazy (Batch Explorer — 

Eksplorator wsadów)
Ctrl-D Usuń zaznaczenie wszystkich obrazów 

(Batch Explorer — Eksplorator wsadów)
Ctrl-F Wybierz wszystkie obrazy z flagą 

(Batch Explorer — Eksplorator wsadów)
F4 Dołącz stronę (wybrany dokument)

Insert Wstaw strony do wybranej strony
Delete Usuń wybrane strony lub dokument

F8 Usuń wybrany dokument
C Wybierz narzędzie Flaga
M Wybierz narzędzie Lupa
P Wybierz narzędzie Przesuń
S Wybierz narzędzie Selektor
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Wyświetlanie i edytowanie (cd.)

Przesuń w górę

Przesuń w prawo

Przesuń w dół

Przesuń w lewo

Shift- Obróć o 180°

Shift- Obróć o 90°

Shift- Obróć o 180°

Shift- Obróć o 270°

+ Powiększ
- Pomniejsz

Ctrl+L Podziel dokument (Batch Explorer — 
Eksplorator wsadów)

K Konfiguracja usuwania pustych obrazów
R Zeskanuj ponownie wybrane obrazy
Z Wybierz narzędzie Rysuj obszar

Ctrl-B Wyczyść wybrany obszar
Ctrl-R Przytnij wybrany obszar
Ctrl-Z Cofnij ostatnie wyczyszczenie lub przycięcie
Ctrl-I Kopiuj obszar obrazu

Nawigacja
D Przejdź do dokumentu o numerze...
I Przejdź do obrazu o numerze...

Eksplorator wsadów
Ctrl-Home Pierwszy dokument we wsadzie
Ctrl-End Ostatni dokument we wsadzie

Ctrl-Page Up Poprzedni dokument we wsadzie
Ctrl-Page Down Następny dokument we wsadzie

Przeglądarka obrazów
Home Pierwsza strona dokumentu
End Ostatnia strona dokumentu

Page Up Poprzednie strony — wszystkie dokumenty
Page Down Następne strony — wszystkie dokumenty

• Tryb indeksowania: dostępne są następujące skróty:
E Edytuj pola indeksu
F9 Poprzedni dokument

F10 Następny dokument
F11 Następny nieprawidłowy dokument
F12 Zapisz i zakończ indeksowanie
Esc Anuluj i zakończ indeksowanie





Kodak alaris

Wszystkie znaki towarowe 
i nazwy handlowe używane 
w niniejszym dokumencie 
należą do ich właścicieli.

Znak towarowy Kodak i szata 
graficzna firmy Kodak są 
używane na podstawie 
licencji udzielonej przez firmę 
Eastman Kodak Company.

© 2022 Kodak Alaris Inc.
TM/MC/MR: Alaris
03/22


	1 Rozpoczęcie pracy
	Dodatkowa dokumentacja
	Terminologia
	Uruchamianie oprogramowania Capture Pro
	Wybór skanera
	Quick Start (Szybki start)
	Okno dialogowe Batch Manager (Menadżer wsadów)
	Tworzenie nowego wsadu
	Otwieranie istniejącego wsadu
	Usuwanie wsadu
	Korzystanie z zadań
	Opcje edytowania
	Obracanie obrazu
	Rysowanie obszaru
	Przycinanie obrazów
	Czyszczenie fragmentu obrazu
	Dołączanie stron
	Ponowne skanowanie obrazów
	Usuwanie obrazów
	Usuwanie zakresu dokumentów
	Usuwanie pustych obrazów z wsadu
	Przetwarzanie wyjściowe wsadu
	Usuwanie błędów


	2 Interfejs użytkownika
	Okno główne
	Pasek menu
	Menu File (Plik)
	Konfiguracja stacji roboczej

	Menu Wsad
	Menu Widok
	Menu Przechwytywanie
	Menu Dokument
	Menu Edycja
	Menu Narzędzia
	Okno dialogowe narzędzia Intelligent QC

	Menu Indeks
	Korzystanie z funkcji przeszukiwania bazy danych
	Korzystanie z funkcji Double Data Entry (Podwójne wprowadzanie danych)
	Entry Resolution (Rozwiązanie niezgodności)


	Menu Pomoc
	Paski narzędzi
	Pasek narzędzi Przechwytywanie
	Pasek narzędzi Wsad
	Pasek narzędzi Dokument
	Pasek narzędzi Widok
	Pasek narzędzi Nawigacja
	Pasek narzędzi Flaga
	Pasek narzędzi Edycja
	Pasek narzędzi Indeks
	Pasek narzędzi Dostosowanie skanera

	Eksplorator wsadów
	Przeglądarka obrazów
	Menu kontekstowe obrazu

	Przeglądarka miniatur
	Menu kontekstowe Przeglądarki miniatur

	Narzędzie Intelligent QC
	Okno Indeks
	Okno Informacje
	Okno stanu przetwarzania wsadu

	Pasek stanu
	Modyfikacja interfejsu okna głównego

	3 Rozwiązywanie problemów
	Wsparcie techniczne

	Dodatek A Skróty klawiaturowe



